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Outline
5 Introduction to Altera® & Altera Devices
5 PLD Design Flow
5 Quartus® II / Synplify Pro Overview
5 Design & Synthesis with Synplify Pro

− Exercises 1 & 2
5 Quartus II Project Management & Compilation

− Exercise 3
5 NativeLink®

− Exercise 4
5 Optimizing Designs with Synplify Pro & Quartus II

− Exercises 5 & 6
5 TCL Scripting
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Course ObjectivesCourse Objectives
5 Set Up Constraints and Perform HDL Synthesis with 

Synplify Pro
5 Optimize FPGA Designs for Higher Performance
5 View & Control Synthesis & Place & Route Results
5 Analyze and Debug Designs with Synplify Pro
5 Set Up Projects and Compile Designs in Quartus II
5 Use Quartus II MegaWizard Plug-In Manager to 

Generate LPM Functions
5 Synthesize and Place & Route a Design Using Black-

box
5 Use Synplify Pro Driven Design Flow
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Introduction to Altera
& Altera Devices

Introduction to Altera
& Altera Devices
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The Programmable Solutions Company®The Programmable Solutions Company®

5 Programmable Devices
5 Design Software
5 Intellectual Property (IP)
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5 Programmable Logic Families
− High & Medium Density FPGAs

3 Stratix™ II, Stratix, APEX™ II, 
APEX 20K, & FLEX® 10K

− Low-Cost FPGAs
3 Cyclone™ & ACEX® 1K

− FPGAs with Clock Data Recovery
3 Stratix GX & Mercury™

− CPLDs
3MAX® 7000 & MAX 3000

− Embedded Processor Solutions
3 Nios™, ExcaliburT™

− Configuration Devices
3 EPC

Introduction to Altera DevicesIntroduction to Altera Devices
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Introduction to Altera Design SoftwareIntroduction to Altera Design Software

5Software & Development Tools: 
− Quartus II
3Stratix II, Stratix, Stratix GX, Cyclone, 

APEX II, APEX 20K/E/C, Excalibur, & 
Mercury Devices
3FLEX 10K/A/E, ACEX 1K, FLEX 6000,  

MAX 7000S/AE/B, MAX 3000A Devices

− Quartus II Web Edition
3Free Version 
3Not All Features & Devices Included

− MAX+PLUS® II
3All FLEX, ACEX, & MAX Devices
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Typical PLD Design FlowTypical PLD Design Flow
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Typical PLD Design Flow

Synthesis
- Translate Design into Target Technology Primitives
- Optimization to Meet Required Area & Performance Constraints

Design Specification

Place & Route
- Map Primitives to Specific Locations Inside

Target Technology
- Specify Routing Resources to Be Used
- May Require Design Edits

Design Entry/RTL Coding
- Behavioral or Structural Description of Design

RTL Simulation (Quartus II or 
ModelSim®)

- Functional Simulation
- Verify Logic Model (No Timing Delays)
- May Require Design Edits
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Typical PLD Design Flow

Timing Analysis
- Verify Performance Specifications Were Met
- May Require Design Edits

Gate Level Simulation (Quartus II or 
ModelSim)

- Timing Simulation
- Verify Design Will Work in Target Technology
- May Require Design Edits

PC Board Simulation & Test
- Simulate Board Design
- Program & Test Device on Board
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Synplify Pro / Quartus II File Flow Overview

Synthesis

3rd Party
EDA Tool

Design
Simulation

5 Synplfiy Pro Synthesis
– Library Mapping File
– Verilog Quartus Mapping File

5 Quartus II Place & Routing
– Verilog Output File
– VHDL Output File
– Standard Delay Format File

5 Third-Party EDA Simulation

.vqm
or

.edf

.lmf

.vo .vho .sdo
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Why Synthesize with Synplify
Pro?
5Better Quality of Results

− Better Fmax and smallest LE usage
− Synplicity dedicated to synthesis and 

simulation
− Synplify Pro maps directly to Altera primitives
− Automatic Altera megafunction use (+, -, *, 

RAM, etc…)
5Better Error Messages and Easier Debugging

− Better verilog and VHDL error messages
5Some Assignment Passing Capabilities
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Quartus II / Synplify Pro
Overview

Quartus II / Synplify Pro
Overview



Copyright © 2004 Altera Corporation

Quartus II Development SystemQuartus II Development System
5Fully-Integrated Design Tool

− Multiple Design Entry Methods
− Logic Synthesis
− Place & Route
− Simulation
− Timing & Power Analysis
− Device Programming
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More FeaturesMore Features
− MegaWizard® & SOPC Builder Design Tools
− LogicLock™ Optimization Tool
− NativeLink® 3rd-Party EDA Tool Integration
− Integrated Embedded Software Development
− SignalTap® II & SignalProbe™ Debug Tools
− Windows, Solaris, HPUX, & Linux Support
− Node-Locked & Network Licensing Options
− Revision Control Interface
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Intellectual Property (IP) Support
5MegaCore® Program

− Staffed with Altera employees
− MegaCore group develops functions that support the 

PCI bus interface, DSP applications, and 
communication applications

5 AMPPSM Program (Altera Megafunction Partners 
Program) 
− AMPP partners are 3rd party IP developers who 

design IP optimized for Altera devices
5 Both programs support OpenCore which allows designers 

to evaluate megafunctions prior to licensing
Visit www.altera.com ⇒ Intellectual Property ⇒
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IP MegaStoreTMIP MegaStoreTM
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System-Level Verification
5SignalTap logic analyzer offers system-

level verification of devices running at 
speed
− Verification times are reduced
− Megafunction provided free of charge with 

Quartus II
5SignalTap works together with Quartus II 

and the MasterBlasterTM or 
ByteBlasterMVTM communication cables
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Internet-Enabled Support
5Register users
5Download software updates
5Obtain license files
5Submit and monitor service requests with 

Altera Applications
5Evaluate and purchase MegaCore 

functions
5Search Atlas® database and other 

technical support pages
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Internet Capabilities
5 Launch Altera web support from within Quartus II

− Help > Altera on the Web>
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What’s New In Quartus II 4.0?What’s New In Quartus II 4.0?
5Stratix II Support
5RTL Viewer
5MAX+PLUS II “Look & Feel”
5SignalTap II Advanced Triggering
5Chip Editor Enhancements
5Single Assignment File (.QSF)
5Revisions
5Balanced Optimization Technique
5Auto Fitter Effort
5New Design Space Explorer Interface
5Early Power Estimation
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Questions about Quartus II?Questions about Quartus II?
5 Quartus II on-line Help has the answers

− Contains the complete up-to-date information on Quartus II
− Provides tips on how to effectively work with Quartus II tools
− Provides answers and examples

5 To access on-line Help
− Help menu content:
3Starting Projects
3Creating and editing files

− Using AHDL, VHDL, Verilog
− Libraries: logic functions, Megafunctions, Primitives

3Using other EDA tools
3Programming or configuring a device

− Press F1 or Shift-F1 to access context sensitive help 
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Synplify Pro FPGA Synthesis 
Product
Synplify Pro FPGA Synthesis 
Product
5 Synplify Pro Is a Synthesis Tool Produced by 

Synplicity

5 Synplify Can Synthesize both Verilog and VHDL 
Designs
− Can Synthesized Mixed Designs

5 Supported on Multiple Platforms
− Windows XP / Windows 2000 / Windows ME / 

Windows NT / Windows ’98 
− Sun OS / Solaris
− HP-UX
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Synplicity’s Current ProductsSynplicity’s Current Products
Certify®

Amplify®

Physical Optimizer™

Certify SC™

Synplify Pro®

and Synplify®

Synplify ASIC®

ASIC solutions

FP
G

A
solutions

brings leading-edge
logic synthesis and

verification products
to FPGA and ASIC

designers

Synplicity
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Synplicity Product ComparisonsSynplicity Product Comparisons

Synplify® Pro
• Challenging Designs
• Complex Projects
• The Ultimate in FPGA 

Synthesis

Synplify®

• Fast
• Easy to Use
• Excellent Results

Amplify™ Physical Optimizer™

 Physical Synthesis for FPGAs
• Highest Circuit Performance
• Fastest Timing Closure
• Option to Synplify Pro
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Synplify Pro FeaturesSynplify Pro Features
5 HDL Analyst
5 Text Editor
5 Behavior Extraction Synthesis Technology (B.E.S.T.)
5 Synthesis Constraint Optimization Environment 

(SCOPE) Editor 
5 FSM (Finite State Machine) Support

− FSM Compiler / FSM Explorer / FSM Viewer
5 Invoke Place & Route via NativeLink
5MultiPoint ™ Synthesis Flow
5 Stratix MAC Support
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Synplify Pro Versus Synplify 
(Partial)
Synplify Pro Versus Synplify 
(Partial)

Feature Synplify 
Pro

Synplify
B.E.S.T. X X
Text Editor X X
HDL Analyst X Optional
FSM Compiler X X
FSM Explorer/Viewer X
SCOPE X X
Log Watch Window X
Text Editor Cross-Probing X
Multiple Implementations X

Note: Please See On-Line Help in Synplify Pro or 
Synplify for a Complete List of Feature 
Differences (Help ⇒Synplify Pro vs. Synplify)



28
Copyright © 2004 Altera Corporation

Synplify Pro User InterfaceSynplify Pro User Interface

Log Watch 
Window

TCL Script & 
Messages Window

Button Panel

Status Bar

Project  
Window
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Getting Help with Synplify ProGetting Help with Synplify Pro
5 On-line Help

− Select Help->Help, or [F1] Function Key from the 
Synplify Pro UI

5 Synplify Pro Documents 
(Start menu ⇒Synplicity ⇒Synplify Pro Documents) 
− Synplify Pro User Guide & Tutorial (synplify_ug.pdf)
3Overview of User Interface and Synthesis 

Guidelines
− Synplify Pro Reference Manual (synpro_ref.pdf)
3Details on the User Interface
3VHDL and Verilog Basics & Support

− Synplify Pro Release Notes (synpro_rnotes.pdf)
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Designing with
Synplify Pro

Designing with
Synplify Pro
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5Design Flow & Synthesis Overview
5Entering & Checking HDL Code
5Simple Synthesis Steps
5Using SCOPE Editor
5Timing Constraints

Agenda
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Synplify Pro Input/Output File 
Flow
Synplify Pro Input/Output File 
Flow

VHDL Verilog

VM or 
VHM

VQM 
or 

EDF

TCL

Design 
Constraints

(SDC)
Technology 

Library
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Synplify Pro InputsSynplify Pro Inputs
5 Design Files

− VHDL
− Verilog

5 Technology Library
− Building Blocks 

(Primitives) Specific to 
Targeted Device Family

5 Design Constraints (SDC)
− Timing Constraints
− Synthesis Control 

Attributes

Technology 
Library

VHDL Verilog

VM or 
VHM

VQM 
OR 
EDF

TCL

Design 
Constraints 

(SDC)
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The Synthesis ProcessThe Synthesis Process
5 Compilation

– Technology Independent

5Mapping
– Technology Specific
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CompilationCompilation

5 Syntax Checking of HDL Code
5 HDL Conversion to Technology-Independent Netlist
5 Extraction of High-Level Structures by B.E.S.T. Algorithms 

– RAM/ROM
– Arithmetic & Logical Operators

5 FSM Extraction & Optimization
5 Resource Sharing
5 RTL Optimizations
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MappingMapping

5 Technology-Independent Netlist as Input
5Mapping to Technology-Specific Structures

– Look-Up Tables
– Registers
– MAC’s (Stratix/StratixII)

5 B.E.S.T. Mapping to Technology Specific Resources
– RAM/ROM ⇒ESBs

5 Timing Driven Synthesis & Optimization
– Logic Replication
– Buffering



37
Copyright © 2004 Altera Corporation

Synplify Pro OutputsSynplify Pro Outputs
5 VQM or EDF File

− Design Representation
− Technology-Specific Netlist
− VQM (Stratix, Stratix II, APEX II, 

All APEX, Mercury, Excalibur)
− EDF (All FLEX, ACEX, MAX)

5 TCL Files
− Used with Execute & Control 

Quartus II
− Used to Pass Design 

Constraints to Quartus II
− More Details Discussed Later

5 VM, VHM Files
− Verilog & VHDL Post-Synthesis 

Netlist Files
− For Post-Synthesis Simulation

VHDL Verilog

VM or 
VHM

VQM 
OR 
EDF

TCL

Design 
Constraints 

(SDC)
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Synplify Pro Text EditorSynplify Pro Text Editor
5 Open File

– File -> New
– File -> Open an Existing File

5 Integrated with Synthesis Environment
– Allows Cross-Probing with Log File
– Allows Syntax & Synthesis Checking on the HDL 

Source Code

5 Column Editing (Alt-Left Mouse Button)
5 Block Commenting (Alt-C)
5 Automatic Keyword Completion (Hit Esc 

Key)
5 HDL Syntax Coloring
5 Line Numbering

Create 
New HDL 
File
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Supported Verilog95 ConstructsSupported Verilog95 Constructs
5All operators
 (+, -, *, /, %, <, >, <=, >=, ==, !=, ===, !==, &&, ||, !, ~, &, ~&, |, 

~|, ^~, ~^, ^, <<, >>, ?:, {}, {{}}) 
 [Note: / and % supported for compile-time constants and 

constant powers of 2]
5Behavioral statements
 if-else-if, case, casex, casez, for, repeat, while, forever, 
 begin, end, fork, join

5Procedural assignments
 =, <= [Note: '<=' cannot be mixed with '=' for the same

register]
5Compiler directives
 `define, `ifdef, `else, `endif, `include
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Supported Verilog2001 
Constructs
Supported Verilog2001 
Constructs
5 Additional constructs on top of Verilog95 support
5 ANSI C style module declarations

− Combining both port and data type declarations in the port 
list of modules, functions and tasks

5 Sensitivity list 
− Can combine comma and “or” to separate signals
− Can use @* or @(*) to include all signals in procedural 

block
5 Signed arithmetic

− reg and net data types can be declared using the reserved 
keyword signed

− Signed operations can be performed for any vector length 
− Integer literals can also be specified using ‘sradix or

size’s<radix>
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More Supported Verilog2001 
Constructs
More Supported Verilog2001 
Constructs
5Explicit inline parameter declaration

− Assign parameter value by name in 
instantiation

− No need to specify all parameter values 
− Parameters in any order

5$signed and $unsigned support
5** operator supported only for base 2

5Generate loops and conditional generate
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Verilog 2001 Support in Synplify 
Pro
Verilog 2001 Support in Synplify 
Pro
5Switch in Implementation Options

− ON by default for new projects
− Can be implemented in the project file as 

set_option –lang_std v2001|v95



43
Copyright © 2004 Altera Corporation

5Parameter override using # and defparam (down 
one level of hierarchy only)

 
 

Parameter Override in VerilogParameter Override in Verilog

Using “#” to override 
parameter

Using “defparam” to 
override parameter

 module sqrtb(z,a);
 parameter asize=4;
 output [(asize-1):0] z;
 input [(asize-1):0] a;
 …
 endmodule

 module sqrterr(e, a);
 output [7:0] e;
 input [7:0] a;
 …
 sqrtb #(8)  sq1(.z(e), .a(a));

 module sqrterr(e, a);
 output [7:0] e;
 input [7:0] a;
 …
 sqrtb sq1(.z(e), .a(a));
 defparam sq1.asize = 8;
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Supported VHDL StandardsSupported VHDL Standards
5Synplify Pro software supports a synthesizable 

subset of VHDL’93 (IEEE 1076), and the 
following IEEE library packages:
− std_logic_1164 
− numeric_std 
− std_logic_unsigned 
− std_logic_signed 
− std_logic_arith

 Note : The VHDL compiler follows the VHDL’93 coding style, 
this

 should be remembered especially during post-synthesis
 simulations.
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Supported VHDL Language 
Constructs
Supported VHDL Language 
Constructs
5 Inputs, outputs and inouts of the following types

− std_logic, std_logic_vector, integer, positive, signed, unsigned, 
records, arrays &  user-defined types

5All operators
− Logical

 AND, NAND, OR, NOR, XOR, XNOR
− Arithmetic

 +, -,*, **, /, rem, mod
− Relational

 >,  <, =, >=,  /=, <=
− Shift Operators

 Shift_Left, Shift_right, Rotate_Left, Rotate_right,SHL, SHR, SHL, 
SHR
5Behavioral statements

if-else-if, case, if-generate, for-loop, for-generate, when
5Assignments

<=[for signals], :=[for variables]
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GenericsGenerics
5Generics are supported
 

 entity sqrtb is
 generic (asize : integer := 4);
 port( z : out bit_vector(asize-1 downto 0);
 a : in bit_vector(asize-1 downto 0));
 end sqrtb;

 architecture arch1 of sqrtb
 …
 end arch1;

 entity sqrterr is
 port( e : out bit_vector(7 downto 0);
 a : in bit_vector(7 downto 0));
 end sqrterr;

 architecture arch2 of srterr is
 begin
 sq1 : sqrtb generic map (asize => 8)
 port map( z => e, a => a);
 …
 end arch2;
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Mixed Verilog/VHDLMixed Verilog/VHDL
5Mixed HDL design support

− Can add both Verilog and VHDL files to project
5The top module/entity name has to be specified in the 

Implementation options
− If a Verilog file instantiates a VHDL design, the Verilog 

language rules apply
− Similarly if a VHDL file instantiates a Verilog design, the 

VHDL language rules apply
5Current limitations

− Generics or parameters cannot be passed across 
language boundaries

− VHDL user-defined types for ports cannot be used 
across language boundaries
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Mixed HDL DesignsMixed HDL Designs
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Syntax & Synthesis CheckingSyntax & Synthesis Checking

Must Have 
Text File 
Open

Select 
Syntax or 
Synthesis 
Check

5 Syntax Check (Shift + F7)
− Looks for Common Syntax Errors like Punctuation and Incorrect 

Keywords
5 Synthesis Check (Shift + F8)

− Looks for Hardware Related Errors like Incorrectly Coded Flip-
Flops
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Syntax & Synthesis Error 
Location
Syntax & Synthesis Error 
Location

Questionable Code Is 
Highlighted.  Click on 
Highlighted Code &…

Bottom of Text Editor 
Window Displays Error 
Message Related to 
Highlighted Code



51
Copyright © 2004 Altera Corporation

Basic Synthesis StepsBasic Synthesis Steps
1) Create Project
2) Add Input Files
3) Create or Edit Implementation

• Pick Device
• Global Clock Frequency

4) Click on the                         Button

5) View/Analyze Results
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1) Synplify Pro Projects1) Synplify Pro Projects
5Must Be Created to Perform Synthesis
5 Contain Data Needed for a Particular Design

– Source (Input) Files
– Device Options
– Constraint Files (SDC)
– Multiple Implementations
– Compiler & Mapper Options
– Synthesis Results File
– Global Frequency

5 Are Stored in .PRJ Files
– ASCII Text File Containing TCL Commands
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Creating New ProjectsCreating New Projects
In the Synplify Project Window, 
select Open Project and then click 
on New Project
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Creating New Projects (cont.)Creating New Projects (cont.)

Save & Name the Project 
from the File menu
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Project ImplementationsProject Implementations
5 Different Versions of Same Project
5 Each Can Have Different Synthesis 

Options & Constraints
– Device & Speed Grade
– Clock Frequency
– Default State Machine Encoding
– Top-Level Module

5 Current Implementation is 
Highlighted
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2) Add Input Files2) Add Input Files
Click Add File Button 
then Highlight and Add
Files to Window
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HDL File OrderHDL File Order
5 Verilog

− Last File is Considered to be Top-Level Module
3Order of Remaining Files Unimportant

− Can Set Top-Level Module as an Implementation Option

5 VHDL
− Packages Must Be Listed First
3Order of Remaining Files Unimportant1

− Last File is Considered to be Top-Level Module
− Can Set Top-Level Module as an Implementation Option

Note:
1) If entity & associated architecture declarations are in 

separate files, then file containing entity declaration 
must be first
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Mixed HDL DesignsMixed HDL Designs
5 For Mixed HDL Designs, Use Implementation Option 

Dialog Box to Set Top-Level
5 If a Verilog file instantiates a VHDL design, the Verilog 

language rules apply.
5 If a VHDL file instantiates a Verilog design, the VHDL 

language rules apply
5 Current limitations

− Generics or parameters cannot be passed across 
language boundaries

− VHDL User defined types for ports cannot be used 
across language boundaries
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Re-Ordering FilesRe-Ordering Files
Just Click & Drag Top-Level 
File to Bottom of List
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3) Create Implementation3) Create Implementation
Select New Impl… to Open 
the Options for 
Implementation Dialog Box
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Device Tab ⇒ Select DeviceDevice Tab ⇒ Select Device

Choose Device Family

Part # Speed Grade

Package & Pin Count
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Device Tab ⇒ Device Mapping 
Options
Device Tab ⇒ Device Mapping 
Options

Device Mapping Options

These Options Are Specific to the 
Targeted Technology.  Examples:

Map Logic to ATOMs – Produces 
ATOM Level Netlist so Quartus II 
Does Not Have to Perform Synthesis.  
Recommendation: Leave Checked.

Disable I/O Insertion – Inserts I/O 
(Input/Output) Pads into Netlist File.  
Unnecessary in Altera Designs.  
Recommendation:  Leave Checked.

Perform Cliquing – Allows Synplify 
Pro to Make Grouping Assignments 
for Place & Route.  Recommendation:
Only Useful for FLEX 6000.
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Implementation Results TabImplementation Results Tab
Name Implementation

Specify the Directory 
for Output Files

Select Optional Output Files

Mapped Verilog Netlist (VM) & 
Mapped VHDL Netlist (VHM) – Post 
Synthesis, Pre-Place & Route 
Simulation Netlist

Vendor Constraint File – Allows 
Synplify Pro to Pass Place & Route 
to Quartus II

Choose Output File 
Name…Leave File 
Format as Default for the 
Device You Selected
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Verilog/VHDL TabsVerilog/VHDL Tabs
5 Verilog & VHDL

− Fill in Top-Level Module
3If Top-Level File Is Not at the Bottom of the File List
3If Top-Level of Mixed HDL Design

5 VHDL Only
− Specify Enumerated Date Type Encoding
3Not for State Machines (Discussed Later)
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Final Basic Synthesis ControlsFinal Basic Synthesis Controls
Global Clock Frequency – Sets 
Global Frequency to Be Applied to All 
Combinatorial & Registered Paths 
Unless Individual Clock Settings Are 
Used

FSM Compiler/Explorer – Enables 
FSM Optimzation & Encoding 
Selection (Next Slides)

Retiming – Allows Synplfy Pro to 
Perform Register Balancing across 
combinatorial elements. 
(Automatically enables Pipelining)

Pipelining – Allows Synplfy Pro to 
Perform Pipelining on Multipliers & 
ROMs
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FSM Support – FSM CompilerFSM Support – FSM Compiler
5 FSM Compiler

− Extracts State Machines from HDL Code & Instantiates an FSM 
Primitive

− Uses Algorithms Specific to Optimizing State Machines
− Removes Redundant & Unreachable States
− Selects Encoding Based on Number of States
− Allows Various Encoding Styles to be Selected without Changing 

Source File(s)

Number of 
States

Encoding 
Style

0 – 4 Sequential
5 – 24 One-Hot

24 and Up Gray
Synplify Pro Project Window
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FSM Support – FSM ExplorerFSM Support – FSM Explorer
5 FSM Explorer

− Analyzes All Encoding Styles & Selects the Best Option Based on 
Other Design Constraints
3Ignores User-Encoded FSM

− May Give Better Results that FSM Compiler but Takes Longer
− FSM Compiler Must Be Executed First

Synplify Pro Project Window
Extracted State Machine
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Final Basic Synthesis Controls 
(cont.)
Final Basic Synthesis Controls 
(cont.) Resource Sharing – Uses Less Device 

Resources if Larger Logic Blocks 
(Arithmetic Operators) Can Be Shared

a
c

b
d

+

+

+

Mux

a
b

c
d
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4) Run Synthesis4) Run Synthesis



70
Copyright © 2004 Altera Corporation

5) Viewing/Analyzing Results5) Viewing/Analyzing Results
5Log File
5Log Watch Window
5HDL Analyst
5RTL View
5Technology View

5FSM Viewer
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Log FileLog File
5 Sections

− Compiler Report
− Mapper Report
− Timing Report
− Resource Usage 

Report
5Messages

− Errors (@E)
− Warnings (@W)
− Notes (@N)

Open Log File
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Log File – Compiler ReportLog File – Compiler Report
5 System & Software Information
5 Project Information

− Source Files
− Top-Level Module

5 Design Information
− HDL Syntax & Synthesis 

Check
− Unused Input Warnings
− Redundant Logic Removal
− RAM/ROM/FSM Extraction
− Black Boxes

Note: Green text indicates cross-probing to source 
code possible.
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Log File – Mapper ReportLog File – Mapper Report
5 Target Technology
5 SCOPE Editor Information

− Constraint Files Read
− Attributes Assigned

5 Design Information
− Design Flattening 

(“Automatic Dissolve”)
− Counter Extraction
− FSM Implementation
− Explicit & Inferred Clocks
− Buffered Nets
− Logic Replication
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Log File – Timing1 ReportLog File – Timing1 Report
5 Required & Estimated 

Clock Frequencies
5 Required & Estimated Top-

Level I/O Timing
− Bi-directional Appears 

as Both Input & Output
5 Critical Path Analysis

Note:
1) Timing values are based on estimation.  Actual timing will

come from Quartus II after place & route.
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Log File – Resource Usage 
Report
Log File – Resource Usage 
Report 5 I/O Usage

5 Logic Elements (LEs) Usage
5 Embedded System Blocks 

(ESBs) Usage
− RAM/ROM
− Logic

5 I/O Cell Register Usage
5 Number of Counters
5 Part/Package Information
5 Device Utilization 

Percentage
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Exercise 1
Please go to Exercise 1
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Exercise 1 ReviewExercise 1 Review
5 Easy Synthesis Steps

1. Create Project
2. Add Files
3. Create/Edit Implementation

– Select Device
– Enter Global Clock Frequency

4. Hit Run Button
5. View Log File 
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Log Watch WindowLog Watch Window
5 Displays Log File Parameters in Tabular 

Format
− Requested Clock Frequency
− Estimated Clock Frequency
− I/O Count

5 Can Display Results from Multiple 
Implementations

5 Updated at the End of Synthesis
Log Watch Window
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Log Watch Window – Setting 
Parameters
Log Watch Window – Setting 
Parameters

Click Log Parameter
box and then Use 
Drop-down Menu to 
Select Parameter

Values Updated 
after Synthesis
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Log Watch – Multiple 
Implementations
Log Watch – Multiple 
Implementations

Right-Click on Column and 
Select Configure Watch

Choose 
Implementations 
to View and 
Click OK
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HDL AnalystHDL Analyst
5 Graphical Representation of HDL Design

− RTL View
3User Sees Exactly What Is Written
3High-Level, Technology Independent Schematic

− Variable Width Adders
− State Machines
− RAM/ROM

− Technology View
3User Sees Exact Components Used to Implement Design
3Low-Level, Technology Specific Schematic

− LUTs
− Flip-Flops
− Muxes

3Allows Critical Path Viewing & Timing
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HDL Analyst Advanced FeaturesHDL Analyst Advanced Features
5Hierarchical and Flattened Views 
5Advanced Filtering
5Crossprobing from Place and Route 

timing files
5FSM Viewer
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RTL ViewRTL View
Opens RTL View

Hierarchy 
Browser

RTL View
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RTL View FeaturesRTL View Features
5 Hierarchy Browser

− Breaks Down Design Using Symbols & Logic Names
5 Push/Pop Control

− Allows User to Enter & Exit Sub-Levels of Hierarchy
5 Flattened Hierarchy

− Displays Entire Design As Generic Logic Symbols
5 Filter Schematic

− Allows User to Isolate RTL View on Selected 
Component(s)

5 Cross-Probing
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RTL View - Hierarchy BrowserRTL View - Hierarchy Browser

Hierarchy 
Tree

Top-Level 
Port & Net 
List

Expanding Instances Allows 
User to View Ports, Nets, & 
Logic for Internal Modules

Highlighting a Net, Port, or Instance in 
the Hierarchy Browser Highlights/Views 
that Construct in the RTL View Window



86
Copyright © 2004 Altera Corporation

RTL View – Push/PopRTL View – Push/Pop
Push/Pop 
Button

No Hierarchical 
Boundary to 

Navigate

“Pushes” (Descends) 
Down into Selected 
Hierarchical Block

“Pops” (Ascends) 
Out of Current 

Hierarchical Block

Mouse Pointers Below Indicate 
which Operation Will Be 
Performed by a Left-Mouse Click
in the RTL View Window
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Filtered RTL ViewFiltered RTL View
Un-Filtered

User Can Select 
Components

Filtered
Only Selected 

Components Shown

Right-Click for 
Pop-Up Window
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Other Filtered View ControlsOther Filtered View Controls
5 Select Net Driver

− Adds to the Filtered View the 
Driver of the Selected Net 
(Fan-In)

5 Select Net Instances
− Adds to the Filtered View 

Everything Connected to 
Selected Net (Fan-Out)

5 Expand Paths
− Shows All Instances/Nets in 

the Path Between Two 
Selected Components
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Technology ViewTechnology View
Opens Technology View
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Technology View FeaturesTechnology View Features
5 Hierarchy Browser
5 Push/Pop Control
5 Flattened Hierarchy
5 Flattened to Gates View

− Displays Design Down to Boolean Logic
5 Filter Schematic
5 Critical Path

− Highlights Instances & Nets in Critical Paths
− Displays Timing

5 Cross-Probing
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Technology View – Critical PathTechnology View – Critical Path
View Critical Path

Filter Critical Path
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FSM ViewerFSM Viewer
5 FSM Viewer

− Displays 
3Transition Bubble Diagram
3Transition Table
3FSM Encoding

− Open FSM from the RTL View
3Push into FSM block
3Right-Click on Extracted FSM and Select View FSM
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FSM Viewer WindowFSM Viewer Window

Bubble Diagram

Mapping Information Tabs



94
Copyright © 2004 Altera Corporation

Mapping Information TabsMapping Information Tabs
5 Transitions (Previous Slide)

− Simple Equations/Conditions for each State Transition
5 RTL Encoding

− Shows State Machine as One-Hot Encoding
5Mapped Encoding

− Shows State Machine as Implemented in Technology
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FSM Viewer FeaturesFSM Viewer Features
5 Use Filter to Isolate States

− Selected
− By Input Transitions
− By Output Transitions

5 State Properties
− Shows State Name, RTL 

Encoding, & Mapped Encoding
− Right-Click on State in Bubble 

Diagram
5 FSM Info File

− Text Description of FSM
− Right-Click on FSM in RTL View

State “01” Filtered 
By Output 

Transitions
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FSM Info FileFSM Info File
State Machine: work.Prgm_Cntr(rtl)-stacklevel[0:2]
No selected encoding - Synplify will choose
Number of states: 3
Number of inputs: 3
Inputs:

0: OPCODE_RETLW
1: OPCODE_GOTO
2: OPCODE_CALL

Clock: CLK
Reset: RESET to state S0
Transitions: (input, start state, destination state)
-01 S0 S1 
-1- S0 S0 
--0 S0 S0 
-01 S1 S2 
-1- S1 S1 
0-0 S1 S1 
100 S1 S0 
--1 S2 S2 
-1- S2 S2 
0-- S2 S2 
100 S2 S1 
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SCOPESCOPE
5Graphical, spread-sheet format to enter and 

manage timing constraints and attributes
5Has the capability of initializing clocks, inputs and 

outputs
5Has auto-fill capability in order to help in filling 

the constraints and attributes
5Filters out objects based on the constraint or 

attribute applied
5Filters attributes and constraints based on the 

object selected
Note: Design should be compiled at least once before using SCOPE
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SCOPESCOPE

New Constraints 
File Toolbar Button 
Opens the Intialize
New Constraint File 
Dialog Box

Choosing Initialize Tells Synplify 
Pro to Initialize the Constraint File 
(SDC) with All Port & Clock Names
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SCOPE EditorSCOPE Editor
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Using SCOPEUsing SCOPE
Use Drop-Down Menus 
to Select Object Name 
and Allowed Values

Each Constraint Can 
Be Individually 
Enabled or Disabled

Type in Other 
Settings & 
Comments
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Using SCOPE (cont.)Using SCOPE (cont.)
5 Synplify Pro tool allows dragging and dropping of objects 

from HDL Analyst Module to SCOPE  editor
5 SCOPE editor also uses specific abbreviation in order to 

distinguish same names for different objects
− v: module or view
− n: net
− p : port
− i: instance
− b: bit slice
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SCOPE TabsSCOPE Tabs
5Clocks
5Inputs/Outputs
5Registers
5Multi-Cycle Paths
5False Paths
5Attributes
5Compile Points
5Other
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Add SCOPE File to ProjectAdd SCOPE File to Project

Save SCOPE Window 
as a SDC File and 
Add to Project
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Add SCOPE File to ImplementationAdd SCOPE File to Implementation

If Multiple SCOPE Files in 
Single Project, Each 
Implementation Selects 
Which SCOPE Files to Apply
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Timing ConstraintsTiming Constraints
5Importance of Timing Constraints
5SCOPE Timing Assignments
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Importance of Timing ConstraintsImportance of Timing Constraints
5 The Synplify Pro synthesis engine is based on timing 

driven synthesis  
− Giving accurate timing constraints leads the tool to 

perform better 
− The Synplify Pro tool does extensive optimization, 

replication and buffering in order to achieve specified 
timing goals

− The Synplify Pro tool does intelligent packing of 
registers in the I/Os depending on the timing specified

5 Forward annotation to Quartus II 
− The timing information is forward annotated to Quartus 

II hence it is important to specify detailed timing 
constraints
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Importance of Timing Constraints 
(cont.)
Importance of Timing Constraints 
(cont.)
5Use Realistic Timing Constraints

− Paths Ranked According to Applied Timing 
Constraints
3Synplify Pro Works on the Most Critical

− Unnecessary Paths Optimized 
− Area Sacrificed to Meet Performance
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Types of Timing PathsTypes of Timing Paths
Input to 
Register 

Register 
to Output 

Register to  
Register

Input to Output 
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Timing ConstraintsTiming Constraints
5 Essential for achieving the performance goal

D Q

D Q

define_output_delay

define_multicycle_path
define_clock

define_input_delay

Delay

Delay

Big Delay
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Clock FrequencyClock Frequency

Clock Period

5 For Data Transfer to Occur Correctly, 
Tco + Tcomb + Tsu < Clock Period

5 Clock Frequency Is the Most Important Setting
– Guides Combinatorial Logic Synthesis
– Guides Reduction of Logic Levels between Registers
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Effects of Timing ConstraintsEffects of Timing Constraints
1 MHz Clock Setting

100 MHz 
Clock 
Setting

Original Logic
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Clocks in Synplify ProClocks in Synplify Pro
5Undefined Clocks Will Default to the Global 

Frequency

5Clocks Are Inferred by Synthesizing HDL & 
Tracing Back the Clock Pin of Flip-Flops

5All Clocks (Defined & Inferred) Appear in 
the “Performance Summary” Section of the 
Log File
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SCOPE Editor – Clock TabSCOPE Editor – Clock Tab

5 Clock Ports in Design Automatically Filled In
5 Specify Frequency Value, Units, & Duty Cycle
5 Internally Generated Clocks

− Registers & Instance Outputs
3Apply Constraint to Register/Instance

− Combinatorial Logic Output
3Must Use syn_keep & keepbuf attributes
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Input & Output DelayInput & Output Delay

Logic Logic

Board
Chip

CLK

Tindelay

Board

Logic Logic

CLK

Chip Toutdelay

Input Delay Refers to the 
Arrival Time from an 
External Register to the 
Chip Interface (TCO + TLogic)

Output Delay Refers to 
the Time from the Chip 
Interface to an External 
Register Plus that 
Register’s Setup Time 
(TLogic + TSU)

Note: Default Delays Equal Zero
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SCOPE Editor – Inputs/Outputs 
Tab
SCOPE Editor – Inputs/Outputs 
Tab
5 I/O Ports Automatically Filled In
5 Global or Individual Port Settings
5 input_delay

Constrains Timing for Input & Bi-Directional Ports

5 output_delay
Constrains Timing for Output & Bi-Directional Ports
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SCOPE Editor – Multi-Cycle 
Paths
SCOPE Editor – Multi-Cycle 
Paths
5 Paths Requiring Multiple Clock Cycles for Data Transfer
5 Types

− from
3Constrains All Paths Coming from the Selected Register

− to
3Constrains All Paths Leading to the Selected Register

− through
3Constrains All Paths Passing through the Selected Net



117
Copyright © 2004 Altera Corporation

Effect of Multi-Cycle Path ConstraintEffect of Multi-Cycle Path Constraint

With 
Multi-Cycle

Without
Multi-Cycle

5 Without Multi-Cycle Constraint
– More Logic Is Used
– Longer Mapping Times
– Timing Report Is Inaccurate
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SCOPE Editor – False PathsSCOPE Editor – False Paths
5Specifies Paths with Low or No Priority 

During Optimization
5Path Not Reported During Timing 

Reporting
5Similar to Multi-Cycle Path Tab

− No Value Necessary
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Purely Combinatorial PathsPurely Combinatorial Paths
5Pure Combinatorial Paths Represent 

Unregistered Paths between Input & 
Output Ports
5The Global Frequency Specified Is Used to 

Constrain These Paths
5Make Sure the Global Frequency Specified 

is Set for Purely Combinatorial Paths if 
Performance Is an Issue
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Exercise 2
Please go to Exercise 2
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Exercise 2 ReviewExercise 2 Review
5 Using HDL Analyst

− RTL View
− Technology View

5 Using SCOPE
5Making Timing Settings
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Design & Synthesis SummaryDesign & Synthesis Summary
55 Easy Steps to Synthesis with Synplify 

Pro
− Make Project
− Add Files
− Set Options (Device & Clock Frequency)
− Run
− View Results

5Add Timing Constraints to Improve Results
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Quartus II
Design Environment

Quartus II
Design Environment
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Quartus II Operating EnvironmentQuartus II Operating Environment
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Design Entry MethodsDesign Entry Methods
5Quartus II

− Text Editor
3AHDL, VHDL, Verilog

− Memory Editor
3HEX, MIF

− Schematic Design Entry

53rd-Party EDA Tools
− EDIF
− HDL
− VQM

5Mixing & Matching Design Files Allowed
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Quartus II
Memory Editor

Quartus II
Text Editor

Quartus II
Block Editor

Top-
Level 
File

.bdf

.gdf

Top-level design files 
can be .bdf, .tdf, .vhd, 
.vhdl, .v, .vlg, .edif or 
.edf

.bsf .vhd

Block
File

Symbol
File

Text
File

Text
File

.v

Text
File

Imported from third-
party EDA tools

Mentor Graphics,
Synopsys,
Synplicity,
etc...

Generated within Quartus II

VHDL

Schematic

Schematic
.tdf

Text
File

AHDL

Verilog

.edf
.edif

Text
File

.v, .vlg,
.vhd, .vhdl, 

vqm

MegaWizard®

Manager

Design Entry FilesDesign Entry Files
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Text Design EntryText Design Entry
5Available Features

− Line Numbering in the HDL Text Files
− Preview of HDL Templates
− Syntax Coloring
− When Editing a Text File, an Asterisk (*) Appears Next 

to the Filename  
3Asterisk Disappears after Saving the File

5Enter Text Description
− AHDL (.TDF)
− VHDL (.VHD)
− Verilog (.V)
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Verilog & VHDLVerilog & VHDL
5VHDL- VHSIC Hardware Description Language

− 1987 & 1993 IEEE 1074 Standards Supported
5Verilog - 1995 & 2001 IEEE 1364 Standard HDL

5Create in Quartus II or any Standard Text Editor
5Use Quartus II Integrated Synthesis to Synthesize
5View Supported Commands in On-Line Help

Learn more about HDL in Altera HDL
Customer Training Classes
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AHDLAHDL
5Altera Hardware Description Language

− High-Level Hardware Behavior Description Language
− Used in Altera Megafunctions
− Uses Boolean Equations, Arithmetic Operators, Truth 

Tables, Conditional Statements, etc.

5Create in Quartus II or any Standard Text Editor
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HDL TemplatesHDL Templates

Menu Bar: Edit ⇒ Insert Template…
or Click on the Shortcut Button

Select Language.  Select Template 
Section.  Preview Window Display 
Section
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Quartus II ProjectsQuartus II Projects
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Quartus II ProjectsQuartus II Projects
5Description

− Collection of Related Design Files & Libraries
− Must Have at Least One Designated Top-Level Entity
− Target a Single Device or Can Be Partitioned into 

Multiple Devices
− Store Settings in Quartus Settings File (.QSF)

5Create New Projects with New Project Wizard
− Can Be Created Using Tcl Scripts
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New Project WizardNew Project Wizard
Invoke New Project Wizard

Name of Project Can Be 
Any Name;  Recommend 
Using Top-Level File Name

Select Working Directory

Top-level Entity Does 
Not Need to Be the 
Same Name as Top-
Level File Name
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Add Design Files

• Graphic (.BDF, .GDF)
• AHDL
• VHDL
• Verilog
• EDIF

Notes:
• Files in project directory do not need to 

be added
• Add top level file if filename & entity 

name are not the same

Add User Library Pathnames 
& Files

Add FilesAdd Files
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Add User Library Paths

• User Libraries 
• MegaCore®/AMPP Sm
Libraries

• Pre-Compiled VHDL 
Packages

User LibrariesUser Libraries
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Choose EDA Tools 

Add or Change 
Settings Later

EDA Tool SettingsEDA Tool Settings
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Auto Device or 
Choose a 
Specific Device 

Choose the 
Device Family

Device SelectionDevice Selection
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Use Filters for 
Auto Selection 
or Picking a 
Specific Device

Device SelectionDevice Selection
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Review Results 
& Click on Finish

Done!Done!
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MAX+PLUS II to Quartus IIMAX+PLUS II to Quartus II
5Convert MAX+PLUS II Projects into Quartus II 

Projects
5Assignments Automatically Translated
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Assignments MenuAssignments Menu
5 From Assignments Menu  

Access All Assignment & 
Settings Options 

5 All Settings Can Be Made from 
Assignments ->  Settings
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Editing Project Settings

File>Open Project

5 Existing project must first be opened to edit the settings

Double clicking the .quartus file will auto launch 
Quartus II

OR

OR

Select from most recent projects list
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Editing Project Settings
5Assignments > Settings

Change Settings:
•General
•Files
•User Libraries
•Timing Requirement
•EDA Tool Settings
•Synthesis Settings
•Fitter Settings
•Timing Analyzer
•Design Assistant
•SignalTapII Analyzer
•SignalProbe Setting
•Simulator Settings
•Hardcopy Settings
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5 Displays Project 
Hierarchy after Project 
Is Analyzed

5 Uses
− Set Top-Level Entity
− Make Assignments
− Locate in Design Files, 

Floorplan or Chip Editor
− View Resource Usage
− Drag & Drop 

Hierarchical Blocks

Project Navigator – Hierarchy TabProject Navigator – Hierarchy Tab

Select & 
Right-Click
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Files & Design Units TabsFiles & Design Units Tabs
5 Files Tab

− Shows Files Explicitly Added to 
Project

− Uses
3Open Files
3 Remove Files from Project
3 Set New Top-Level Entity

5 Design Units Tab
− Displays Design Unit & Type

3 VHDL Entity
3 VHDL Architecture
3 Verilog Module
3 AHDL Subdesign
3 Block Diagram Filename

− Displays File which 
Instantiates Design Unit
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Project FilesProject Files
5Quartus Project File (QPF)

− Quartus II Version
− Time Stamp
− Active Revision

5Quartus Default File (QDF)
− Project Defaults
− Name: assignment_defaults.qdf
− Local or Bin Directory
3Local Read First
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Archive Project Creates:
1. <project>.QAR

• Compressed Archive File
• Options to Choose which 
Files Get Archived

2.  <project>.QARLOG
• Log of Archive Activity

Restore Archived Project:
• Restores Complete Project & 
Library Function Files from 
<project>.QAR File

Project Archive & RestoreProject Archive & Restore
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Summary

5Use Project Wizard to create new 
projects
5Use Assignments  Menu dialog boxes 

to
− Edit existing project settings
− Edit Third Party tools

5Use Project Navigator to study file and 
entity relationships within the project



Copyright © 2004 Altera Corporation

Quartus II CompilationQuartus II Compilation
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Quartus II CompilationQuartus II Compilation
5Synthesis
5Fitting
5Generating Output

− Timing Analysis Output Netlist
− Simulation Output Netlists
− Programming/Configuration Output Files
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5 Start Compilation
− Perform Full Compilation

5 Start Analysis & Elaboration
− Check Syntax & Build 

Database Only
5 Start Analysis & Synthesis

− Synthesize Code & Estimate 
Timing

5 Start Fitter 
5 Start Assembler
5 Start Timing Analysis
5 Start I/O Assignment Analysis
5 Start Design Assistant

Processing OptionsProcessing Options
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• Status Bars Scroll to Indicate Progress
• Message Window Displays Informational,

Warning, & Error Messages

Hit the Start Button

Status & Message WindowsStatus & Message Windows
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All Information Is Contained in the Report
• Resource Usage
• Timing Analysis
• Pin File
• Floorplan View

Compilation ReportCompilation Report
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Several Sections Detail the Resource Usage

Resource UsageResource Usage
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FloorplanFloorplan
5Available Views

− Last Compilation
− Chip Editor
− Timing Closure

5Uses
− Make Assignments
− View Placement
− View Connections
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Floorplan ViewFloorplan View
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Controlling Synthesis & FittingControlling Synthesis & Fitting
5Two Methods to Control Logic Synthesis & 

Fitting Operations
− Settings
3Project-Wide Switches

− Assignments (i.e. Logic Options; Constraints)
3Individual Entity/Node Controls



159
Copyright © 2004 Altera Corporation

SettingsSettings
5Examples

− Device Selection
− Synthesis Optimization
− Fitter Optimization
− Physical Synthesis

5Located in Settings Dialog Box 
(Assignments Menu)
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Settings Dialog BoxSettings Dialog Box

Change Settings
• Top-Level Entity
• Target Device
• Add/Remove Files
• Libraries
• VHDL ‘87, ‘93?
• Verilog ‘95, ‘01?
• EDA Tool Settings 
• Timing Settings
• Compiler Settings
• Simulator Settings
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• Smart Compilation
− Used for Incremental Re-

Compilation
− Saves Compiler Time
− Uses More Disk Space

• Preserve Node Names
− Disable for VHDL/Verilog 

Synthesis
• Generate Version-Compatible 

Database

Compilation ProcessCompilation Process
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Version-Compatible DatabaseVersion-Compatible Database
5Recommended
5Exports a Database that Can Be Opened 

Directly in another Version of Quartus II
− Import Database into New Version

5Two Methods to Create
− Settings Dialog Box
− Project Menu

Analyze Previously Compiled Projects 
Using Updated Timing Models
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Global Optimization Goal

�Select Speed vs. Area or Balanced

Logic Replacement

�Replace Logic with Equivalent 
Megafunction

State Machine Processing

�Auto, One-Hot or Minimal Bit

Seed

�Controls Initial Placement 
Configuration

�Different Seeds Give Different 
Fmax

Synthesis OptionsSynthesis Options
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Synthesis Netlist OptimizationsSynthesis Netlist Optimizations
5Further Optimize Netlists during Synthesis
5Types

− WYSIWYG Primitive Resynthesis
− Gate-Level Register Retiming
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WYSIWYG Primitive ResynthesisWYSIWYG Primitive Resynthesis
5 Unmaps 3rd-Party Atom 

Netlist Back to Gates & 
then Remaps to Altera 
Primitives
− Unavailable when Using 

Integrated Synthesis
5 Considerations

− Node Names May 
Change

− 3rd-Party Synthesis 
Attributes May Be Lost
3Preserve/Keep

− Some Registers May Be 
Synthesized Away

4-5 % Improvement
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Gate-Level Register RetimingGate-Level Register Retiming
5Moves Registers across Combinatorial 

Logic to Balance Timing
5Trades between Critical & Non-Critical 

Paths
5Makes Changes at Gate Level

D

>

Q D

>

QD

>

Q7 ns 8 nsD

>

Q D

>

QD

>

Q10 ns 5 ns
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Enabling Synthesis OptimizationsEnabling Synthesis Optimizations

Created/Modified Nodes Noted in Compilation Report
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Timing Driven Compilation

�Optimize Internal Timing

�Optimize I/O Register Placement

Compilation Speed/Fitter Effort

�Standard Fit (Highest Effort)

�Fast Fit (Faster Compile but 
Possibly Lesser Design 
Performance)

�Auto Fit (Compile Stops after 
Meeting Timing)

�One Fitting Attempt

Seed

�Controls Initial Placement 
Configuration

Fitter OptimizationsFitter Optimizations
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Physical SynthesisPhysical Synthesis
5 Re-Synthesis Based on 

Fitter Output
− Makes Incremental 

Changes that Improve 
Results for a Given 
Placement 

− Compensates for Routing 
Delays from Fitter 

5 Types
− Combinational Logic
− Registers
3Register Duplication 
3Register Retiming

5Effort
− Trades Performance vs

Compile Time
− Normal, Extra or Fast
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Combinational LogicCombinational Logic
5Swaps Look-Up Table (LUT) Ports within LEs to 

Reduce Critical Path LEs

5Allows LUT Duplication to Enable Further 
Optimizations on the Critical Path

f
g

a
b - critical LUT

LUT

c
d
e

LUT

LUTf
g

a
e
c
d
b
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Register Duplication Register Duplication 
5High Fan-Out Register Is Duplicated & 

Placed to Reduce Delay
− Combinational Logic May Also Be Duplicated 

N
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Enabling Physical SynthesisEnabling Physical Synthesis

Created/Modified Nodes Noted in Compilation Report
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AssignmentsAssignments
5Assignment Editor
5Example Assignments
5I/O Assignments & Analysis

5Perform Analysis & Elaboration before 
Obtaining Hierarchy & Node Information
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Assignment Editor (AE)Assignment Editor (AE)

Displays File Where the 
Constraint is Stored

Enable/Disable 
Individual
Assignments

Sort on Columns

5 Provides Spreadsheet Assignment Entry & Display
− Can Copy & Paste from Clipboard
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Invoke the Assignment Editor by Highlighting an 
Entity in the Hierarchy View & Right- Clicking

Opening Assignment EditorOpening Assignment Editor

Assignments Menu
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Opening Assignment Editor (cont.)Opening Assignment Editor (cont.)

5Locate to Assignment Editor from Timing Report, 
Messages, Etc
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Using Assignment EditorUsing Assignment Editor

Selecting an Option Determines which Fields Are Available for Editing

Double-Click Cells 
to Edit or Add 
New Assignment 

Launches 
Node Finder
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Editing Multiple AssignmentsEditing Multiple Assignments
5 Edit Multiple Constraints Simultaneously

− Select Multiple Pins & Use Edit Bar (Click Check Mark to Accept)

Editing Multiple I/O 
Standards at Once
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Search by Name 
Using Wildcards 
(? or *)

List of Nodes in Selected Entity
& Lower Levels of Hierarchy

Use Filter to Select the  
Nodes to Be Displayed

Select Nodes on Left 
& Use Arrows to 
Move to the Right

Node FinderNode Finder

Locate Nodes in a Certain 
Level of Hierarchy

Start Displays Nodes 
Meeting Search Criteria
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AE Dynamic CheckingAE Dynamic Checking
5 Validity of Constraint Checked during Entry
5 Color-Coded to Display Status

− Grey – Disabled
− Black – Applied
− Yellow – Not Validated

− Dark Red – Incomplete
− Bright Red – Error/Illegal Value
− Green – Enter New 

Assignment
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Assignment Editor FeaturesAssignment Editor Features
5 Category Bar

− Selects Category of Assignments to View
3Ex. Pin Assignments, Timing Assignments

− Each Can Be Customized
5 Node Filter Bar

− Filters Constraints Displayed Based on Node Name
5 Information Bar

− Displays Description of Selected Cell or Assignment
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AE Tcl CommandsAE Tcl Commands
5 Equivalent Tcl Commands Are Displayed as Assignments 

Are Entered
− Manually Copy to Create Tcl Scripts
− Export Command (File Menu) Writes All Assignments 

to a Tcl File

Message Window



183
Copyright © 2004 Altera Corporation

Export CSV File Assignments (Excel)Export CSV File Assignments (Excel)

5Export to CSV File (File Menu)
− Import Data into Excel
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Example AssignmentsExample Assignments
5Optimization Technique
5PCI I/O
5Output Pin Load
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OPTIMIZATION TECHNIQUEOPTIMIZATION TECHNIQUE
5Selects Synthesis Optimization Goal

− Speed
− Area
− Balanced (Default)

5Applies Only to Hierarchical Entities
5Effects Synthesis & Logic Mapping
5Only Applies to Quartus II Integrated 

Synthesis
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PCI I/OPCI I/O
5Turns on PCI 

Compatibility for Pins
− Ignored If Applied to 

Anything other than a 
Pin or a Top-Level 
Design Entity

5Controls Clamping 
Diode Located in the 
I/O Elements
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Output Pin LoadOutput Pin Load
5 Specifies Output Pin 

Loading in picoFarads
(pF)
− Changes Default Loading 

Value of I/O Standard
− Changes tco of Output Pins

5 Allows Designer to 
Accurately Model Board 
Conditions

5Must Be Applied to 
Output or Bidirectional 
Pins
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Available Logic Options (Assignments)Available Logic Options (Assignments)

1) Go to Quartus II 
Help (Index)

2) Type in “Logic 
Options”

3) Click on “list of”

Supported Devices 
Shown for each 
Assignment 
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Quartus Settings File (QSF)Quartus Settings File (QSF)
5Stores All Settings & Assignments
5Uses Tcl Syntax

Organized by Assignment Type
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I/O (Pin) AssignmentsI/O (Pin) Assignments
5Make I/O Assignments Quickly

− Assignment Editor
− Floorplan
− QSF File
− Import from Spreadsheet in CSV Format
− Scripting

5Specific Pin Location Unnecessary
− IO Bank & Chip Edge Location Assignments
− Reserved Pins with or without Locations
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Assignment Editor I/O AssignmentsAssignment Editor I/O Assignments

Assign to Chip Edge

Assign to (Color-Coded) I/O Bank

Assign to Specific I/O Location

Reserved Pins
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AE Pin Assignment FeaturesAE Pin Assignment Features
5Show All Known Pin Names

− Populates Spreadsheet with List of All Pin 
Names in Design
3Assigned & Not Assigned

5 Show All Assignable Pin Numbers
− Populate Spreadsheet with All Pin 

Numbers Available for Assignment
5Show I/O Banks in Color

− Enable/Disable I/O Color Coding of 
Spreadsheet Based upon Floorplan
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Drag & Drop I/O AssignmentsDrag & Drop I/O Assignments
5Drag & Drop from Node Finder to Floorplan
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Type I/O AssignmentsType I/O Assignments
5Type Pin Assignments Directly into QSF
5Use Tcl Syntax
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Import CSV AssignmentsImport CSV Assignments
5 Use Spreadsheet to Enter 

Pin Assignments & I/O 
Standards

5 Column Header Names
− To
− Assignment Name (Location)
− Value (Pin Number)
− I/O Standard

5 Useful for Interfacing to PCB 
Tools
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I/O Assignment ProblemsI/O Assignment Problems
5I/O Selected & Verified Too Far into Design 

Cycle
5Variety of Complex I/O Standards on 

Single Device
− Not All Supported on Every I/O Block

5I/O Placement Limitations
− Current Strength
− Single-Ended vs. Differential
− Single-Ended vs. Vref
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I/O Assignment Analysis CommandI/O Assignment Analysis Command

5Quickly Checks Legality of I/O Assignments
− Checks All Assignments
− Does Not Stop at First Failure

5Allows User to Identify & Correct Pin-Related 
Issues without Full Compilation
5Has Two Usages

− Performing Legality Checks Based on User Reserved 
Pin Assignments with Partial or No Design Files

− Performing Legality Checks Based on User I/O 
Assignments with a Complete Design
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I/O Assignment AnalysisI/O Assignment Analysis
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I/O Analysis RequirementsI/O Analysis Requirements
5I/O Declaration

− HDL Port Declaration
− Reserved Pin

5Pin-Related Assignments
− I/O Standard
− Current Strength
− Pin Location (Pin, Bank, Edge)
− PCI Clamping Diode
− Toggle Rate
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Legality ChecksLegality Checks
Rule (subset of the rules) Incomplete 

Design
Complete 

Design
Differential Pin Spacing ●
# of Output/Bidirs Toggling with a VREF ●
Blocks Directly Feeding or Fed by I/O pins ●
Current Strength ● ●
DC Current Draw ● ●
Pin Location ● ●
I/O Bank Capacity ● ●
Voltage Conflict (Vref, VCCIO) ● ●
On-Chip Termination ● ●
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I/O Assignment Analysis OutputI/O Assignment Analysis Output
5Detailed Messages on

− I/O Assignment Issues
− Compiler Assumptions
− Device & Pin Migration Issues
− I/O Bank Voltages & Standards

5Compilation Report (Fitter Section)
− I/O Pin Tables
3Show User & Fitter Assigned I/O

− Shows Partial Placement Results in Floorplan
to Help Debug Fitting Errors
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I/O Assignment Analysis MessagesI/O Assignment Analysis Messages

Migration I/O

I/O Standard Statistics

I/O Banks & Pin Usage
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Back-AnnotationBack-Annotation
5Copies Device & 

Resource 
Assignments Made 
by Compiler into 
QSF File
− Pins
− Logic
− Routing

5“Locks Down”
Locations in 
Floorplan
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Design File ManagementDesign File Management
5Project Archive & Restore

− Stores All Project Files
3Design Files
3Settings File
3Output Files

5Revisions
− Stores Only QSF
− Allows Designer to Try Different Options
− Allows Comparison of Revisions
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Creating a RevisionCreating a Revision
5Project ⇒ Revisions

Create New 
Revision Type Revision Description

Base Revision on Any 
Previous Revision



206
Copyright © 2004 Altera Corporation

5Active Revision Names Stored in QPF
5QSF Created for Each Revision

− <Revision_name>.QSF
5Text File Created for Each Revision

− <Revision_Name>_description.TXT

Project Revision SupportProject Revision Support

Easily Switch 
between Revisions
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Compare RevisionsCompare Revisions
5Detailed Summary of 

Results
− Synthesis
3No Timing Data

− Fitting
3Area
3Timing

5Compare Results with 
Other Projects
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Compiling a SubmoduleCompiling a Submodule
1. Open Submodule File
2. Select “Set as Top-Level 

Entity” from Project 
Menu

1. Create a New Revision
2. Leave “Based on 

revision” blank

Quartus II Now Compiles 
acc as the Top-Level

Creates New .QSF File as a Revision Reuses Current .QSF File
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Compilation Entry SummaryCompilation Entry Summary
5Compilation Includes Synthesis & Fitting
5Compilation Report Contains Detailed 

Results
5Settings & Assignments Control 

Compilation
5Pin Assignments Can Be Performed in 

Many Ways
5Revisions Store Settings, Assignments & 

Compilation Results for Comparison
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Summary
5Synthesis & Fitter Options
5Assignment Editor
5Compilation Reports
5Floorplan
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Quartus II Timing AnalysisQuartus II Timing Analysis
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FeaturesFeatures
5Built-In Static Timing Analysis
5Single & Multi-Clock Timing Analysis
5Standard & Minimum Timing Analysis
5Timing Export for Analysis in Another EDA 

Tool
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Timing Analysis AgendaTiming Analysis Agenda
5Single Clock Analysis
5Timing Assignments

− Global & Individual
5Multi-Clock Analysis
5Multi-Cycle Analysis
5Minimum Timing
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Running Timing AnalysisRunning Timing Analysis
5Automatically

− Use Full Compilation
5Manually

− Processing Menu ⇒Start ⇒Start Timing 
Analysis

− Tcl Scripts
− Uses
3Changing Speed Grade
3Annotating Netlist with Delay Information
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Reporting Timing ResultsReporting Timing Results
5 Timing Analyzer Section 

of Compilation Report
− Summary

Timing Analyses
− Clock Setup (fmax)
− Clock Hold
− tsu (Input Setup Times)
− th (Input Hold Times)
− tco (Clock to Out Delays)
− tpd (Pin to Pin Delays)
− Minimum tpd & tco



216
Copyright © 2004 Altera Corporation

Clock Period = Clock-to-Out + Data Delay + Setup Time - Clock Skew
= tco + B + tsu - (E - C)

fmax = 1/Clock Period

B

C

tco tsu

E

Clock Period

Clock Setup (fmax)Clock Setup (fmax)
5Worst-Case Clock Frequency

− Without Violating Internal Setup & Hold Times
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Select 
Clock Setup

Worst fmax
Fmax Values Are Listed in Ascending Order;   
Worst Fmax Is Listed on the Top

Source, Destination 
Registers & Associated 

Fmax Values

Clock Setup (fmax) TablesClock Setup (fmax) Tables
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fmax Analysisfmax Analysis

Highlight, 
Right-Click 
Mouse & 
Select List 
Paths

5To Analyze the Path More Closely

Similar Steps for All Timing Path Analysis in Quartus II
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fmax Analysis Detailsfmax Analysis Details
Data Delay (B)

Source Register 
Clock Delay (C)

Setup Time (tsu)

B

C

tco tsu

E

Clock Period

Destination Register 
Clock Delay (E)

Clock to 
Output (tco)

1
0.099 ns +4.135 ns + 0.093 ns - 0.000 ns

= 231.11 MHz

Messages Window (System Tab) in Quartus II
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fmax Analysis Details (cont.)fmax Analysis Details (cont.)

Interconnect Delay

Cell Delay Running 
Total

Notes:
1) This Timing Convention 

Is Similar for All Timing 
Path Analysis

2) Carry Chain Delay Is 
Included in Cell Delay 
Number

This signal 
path consists 
of 28 locations

Destination Cell 
Name & Type

Node Fan-Out

% Interconnect vs. % Cell Delay
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Right-Click & 
Select Locate

Locate Delay Path in FloorplanLocate Delay Path in Floorplan
Message Window

Notes:
1) Use Similar 

Procedure for All 
Timing Path Analysis

Compilation Report
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Locate Delay Path in FloorplanLocate Delay Path in Floorplan

4.135 ns Is the 
Total Path Delay



223
Copyright © 2004 Altera Corporation

Clock Hold AnalysisClock Hold Analysis
5Checks Internal Register-Register Timing

− Report Occurs Only When Hold Violations Occur
5Results Usually When Data Delay (B) is Greater 

than Clock Skew (E-C)
− Non-Global Clock Routing
− Gated Clocks

B

C

tco tsu

E

Clock Period

E

C

Data

E - C th

tco +B 
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Hold Time Violations TableHold Time Violations Table

Not Operational:  
Clock Skew < Data Delay

Discover Internal Hold 
Time Issues before 
Simulation

List Paths Window
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I/O Setup (tsu) & Hold (th) AnalysisI/O Setup (tsu) & Hold (th) Analysis

Clock delay

tsu
th

Data delay

tsu = data delay - clock delay + intrinsic tsu

intrinsic tsu & hold

th = clock delay - data delay + intrinsic th



226
Copyright © 2004 Altera Corporation

I/O Clock-to-Output Analysis (tco)I/O Clock-to-Output Analysis (tco)

Data delay

tco

Clock delay

clock delay + intrinsic tco + data delay = tco

intrinsic tco
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I/O Timing AnalyzerI/O Timing Analyzer

Clock Name

Select 
Parameter

Pin Name

tsu, tco, th Will All Show up in the Timing Analyzer Report

Value

Note:  Timing Analysis of tpd is similar
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Timing Analysis OptionsTiming Analysis Options
5Used to Limit which Paths Are Displayed 
5Global Cut Timing Options (On by Default)

− Cut Paths between Unrelated Clock Domains
− Cut Off Feedback from I/O Pins (Next Slide)
− Cut Off Clear & Preset Signal Paths
− Cut Off Read during Write Signal Paths

5Timing Analyzer Options
− Display Paths that Do Not Meet Timing Only 
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clk

Q D
A

Register 1 Register 2

5Breaks Bidirectional I/O Pin from Analysis
5When On, Paths A & B Are Valid;  C Is Not
5When Off, Paths A, B, & C Are Valid

I/O
 P

in
C

B

Cut Off Feedback from I/O PinCut Off Feedback from I/O Pin
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Assignments ⇒ Settings ⇒ Timing Requirements & 
Options

Cut OptionsCut Options



231
Copyright © 2004 Altera Corporation

Timing Analyzer OptionsTiming Analyzer Options

List 200 Paths

List Paths with Tsu
Greater than 3 ns

List Paths with Fmax
Less than 250 MHz

Assignments ⇒ Settings ⇒ Timing 
Analyzer
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Single-Clock Timing AnalysisSingle-Clock Timing Analysis
5Performed Automatically during Each 

Compile
5Detects Clocks Automatically If No 

Assignments Are Made
− Single or Multiple Asynchronous Clock 

Domains
− Still Important to Specify Clock Frequencies

5Displays Results in the Timing Analyzer 
Report
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Multi-Clock Frequency AnalysisMulti-Clock Frequency Analysis
5Analyzes Timing on Register-to-Register Paths 

Controlled by Different Synchronous Clocks
− Individual Clocks Treated as Same Frequency & 

Phase Unless Specified

clk1

tco tsu

Combinatorial 
logic

clk2

capturing edge

launching edge

clk1

data

clk2

Register 1 Register 2
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Minimum Timing AnalysisMinimum Timing Analysis
5Reports Best-Case I/O Results

− Minimum tco
− th
− Minimum tpd

5Uses Fastest Timing Model
− Fastest Process
− Highest Voltage
− Lowest Temperature
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Exercise 3
Please go to Exercise 3
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Exercise 3 ReviewExercise 3 Review

5Quartus II Project Setup
− Project Wizard

5Quartus II Compilation
− Assigning a device
− Choosing a focus point

5Reviewing the Compilation Report
− fmax, tsu, tco
− Device statistics
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Quartus II NativeLinkQuartus II NativeLink
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EDA Interfaces IntroductionEDA Interfaces Introduction
5Interface with Industry-Standard EDA Tools that 

Generate a Netlist File
− EDIF 200
− VHDL ’87 or ’93
− Verilog

5NativeLink Interface Provides Seamless 
Integration with 3rd-party EDA Software Tools
− Tools Pass Information/Commands in Background
− Designers Can Complete Entire Design in One Tool
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EDA PartnersEDA Partners

API

External
Files

NativeLinkNativeLink
5 Comprised of Two Components

− External Files
3WYSIWYG (What You See Is What You Get) ATOM Netlist

Files (EDIF, Verilog, VHDL) 
3Cross Reference Files (Ex. XRF)
3Timing Files (Ex. SDO)

− Application Programming Interface (API)
3Pre-Defined Interface of Commands/Functions
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5Set of Design Primitives that Support WYSIWYG 
Compilation
5Provide Direct Control of How a Design Is 

Technology-Mapped to a Specific Target Device
5Allow Synthesis Vendors to Provide an Optimal 

Realization of a Design for Each Architecture

Synplify .vqm

WYSIWYG ATOM PrimitivesWYSIWYG ATOM Primitives
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WYSIWYG Compilation FlowWYSIWYG Compilation Flow

EDIF or 
VQM

Design Input Files 
with

WYSIWYG Primitives

Synthesis

Logic
Synthesis

Netlist 
Extraction

Database 
Builder

Place & 
Route

Note: Logic Options in Quartus II that 
control synthesis can no longer be used.
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Quartus II / Synplify Pro Design 
Flows
5 Quartus II Driven Flow

− Quartus II launches Synplify Pro in Background to 
Perform Verilog or VHDL Synthesis

5 Synplify Pro Driven Flow
− Synplify Pro Starts Quartus II to Perform Place & 

Route
5 File Based Flow

− Manual File Transfer
− Quartus II & Synplify Pro Executed Independently
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Quartus II Driven Flow

− Synplify Pro launched from 
within Quartus II

− Quartus II automatically
3Generates netlists

(AHDL & Graphics)
3Reads in the netlists

(VHDL or Verilog)
− No Manual Setup of 

Synplify Pro Required
TCL 
Commands 
& Files

API

Quartus II drives Synplify Pro
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Quartus II Driven FlowQuartus II Driven Flow
Assignments ⇒ EDA Tool Settings

Check the “Run …” Button to Launch 
the EDA Tool in the Background

Leave Unchecked for File Based Flow
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Synplify Pro Driven Flow

− Offers the tightest 
code-level 
integration between 
tools

− Quartus II appears 
‘Native’ in Synplify 
Pro

Synplify Pro drives Quartus II

API

TCL 
Commands 
& Files
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Synplify Pro Driven FlowSynplify Pro Driven Flow
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SynplifyPro to QuartusII InterfaceSynplifyPro to QuartusII Interface
5 Set Option

− Invokes Quartus II with Project Settings from the 
Synplify Pro Run

5 Run Foreground Compile
− Runs Quartus II with the Project Settings from the 

Synplify Pro Run
5 Run Background Compile

− Runs Quartus II in Batch Mode with the Project 
Settings from the Synplify Pro Run

− Quartus II Log File Is Displayed in the Synplify Pro 
User Interface with Updates of the Quartus II 
Compilation
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Background CompileBackground Compile

Quartus II 
Log File

All Quartus II 
Compilation Messages 
Appear in the in the 
Synplify Pro Window as 
if “Native” to the 
Software.
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Synplify Pro Output TCL FilesSynplify Pro Output TCL Files
5 <PROJECT_NAME>_CONS.TCL

− Creates Quartus II Project
− Starts Compilation

5 <PROJECT_NAME>.TCL
− Forward Annotates Device Selection
− Forward Annotates Timing Constraints & Settings

5 <PROJECT_NAME>_RM.TCL
− Removes Previous Constraints
− Saves Old Constraints in 

<PROJECT_NAME>_PREV.TCL
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Constraint Forward AnnotationConstraint Forward Annotation
5These Constraints Can Be Passed to 

Quartus II
− I/O Delay
− Clock Frequency
− Clock Duty Cycle
− Multi-Clock Settings
− Multi-Cycle Paths
− Pin Assignments
− Cliques/LogicLock Regions
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•Synthesis

•Simulation

•Timing Analysis

•Board-Level

•Formal Verification

•Resynthesis

File Based FlowFile Based Flow
5Work Separately in Individual Tools
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Verification Tools
• ModelSim®

• ModelSim-Altera
• Cadence Verilog-XL
• Cadence NC-Verilog
• Cadence NC-VHDL
• Innoveda BLAST
• PrimeTime®

• Synopsys® VCS & VSS
• Mentor Graphics® Tau
• Synopsys Scirocco

Synthesis Tools
• LeonardoSpectrum™

• Precision
• DesignCompiler-FPGA
• FPGA Compiler II™

• FPGA Express™

• Synplify
• Synplify Pro
• Amplify

Third Party Tool SupportThird Party Tool Support
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Exercise 4
Please go to Exercise 4
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What has been covered so far…?What has been covered so far…?

5 Quartus II
− Design Entry
− Place & Route
− Compilation Statistics
3Performance
3Area

− Device-Specific Logic Options

…The EDA Synthesis Flow
5 Synplify Pro

− Design Entry
− Synthesis Settings
− Synthesis
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Optimizing Designs with 
Synplify Pro & Quartus II 
Optimizing Designs with 
Synplify Pro & Quartus II 
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Optimizing DesignsOptimizing Designs
5Hierarchical Optimization
5“Black-Boxing”
5Attributes & Directives
5Optimization Suggestions
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Hierarchical DesignsHierarchical Designs
5Mapper Starts with the Original hierarchy
5Flattens Hierarchy & Reduces Logic
5Performs Global Analysis and Optimizes 

Hierarchy by Creating New Structures, if Needed
5Rebuilds Hierarchy by Keeping Existing 

Boundaries or Creating New Ones
5Provides Timing Budget for Each Hierarchical 

Block
5Converges on the Timing Goal by Making an 

Area/Time Tradeoff
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Hierarchy Optimization (cont.)Hierarchy Optimization (cont.)

module and2_x(a, b, c);
input a, b;
output c;
assign c = a & b;
endmodule

module top(a0, a1, b, c);
input a0, a1, b;
output c;
and2_x an1(a0, a1, an1_out);
and2_x an2(an1_out, b, c);
endmodule

Two Levels of Logic Generated without 
Hierarchical Boundary Optimization

Logic Implemented in One Lookup table 
with Hierarchical Boundary Optimization
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Black-BoxingBlack-Boxing
What is a “black-box” and why is it used?
5 A Module/Entity that Is Left Untouched (Un-Synthesized) 

by Synplify Pro
− Surrounding Logic Still Synthesized

5 Output Netlist Includes Port Connections to “Black-Box”
5 “Black-Box” code is Inserted by Quartus II
5 Use for LPMs or Altera Specific Megafunctions

− CDR (Clock Data Recovery)
− RAM/ROM
− CAM (Content Addressible Memory)
− CLOCKLOCK® /CLOCKBOOST®
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LPM FunctionsLPM Functions
5 LPM Library Elements

− Library of Parameterized Modules
3Pre-Designed Modules You Can Customize for Your Design

− Edit
3I/O Ports
3Parameters

− Width of Data
− Memory Depth

− Optimized for All Altera Architectures
− Utilize the Architectural Features of All Altera Devices
3ESBs/EABs
3CDR
3PLLs
3LVDS
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Black-boxingBlack-boxing

Top_module.v

Counters

Adders
RAM
Black 
Box

LPM RAM function 
not recognized by 

Synplify Pro

Quartus II 

inserted

LPM Function
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MegaWizard Plug-In ManagerMegaWizard Plug-In Manager
5 Eases Implementation of 

Megafunctions & IP



263
Copyright © 2004 Altera Corporation

MegaWizard Examples MegaWizard Examples 
Multiply-Add PLL

Double-Data Rate
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MegaWizard Output File SelectionMegaWizard Output File Selection

5Default
− HDL Wrapper File

5Selectable
− HDL Instantiation 

Template
− VHDL Component 

Declaration (CMP)
− Quartus II Symbol 

(BSF)
− Verilog Black Box
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Black-boxing a Dual-Port RAM 
(Step 1)
Black-boxing a Dual-Port RAM 
(Step 1)

Choose Verilog/VHDL output file

1) Create my_ram, a dual-port
RAM megafunction in
Quartus II using MegaWizard
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Black-boxing a Dual-Port RAM 
(Step 1)
Black-boxing a Dual-Port RAM 
(Step 1)

See Appendix on how to use the 
memory editor in Quartus II to 
initialize RAM/ROM/CAM.

1) Create my_ram, a dual-port
RAM megafunction in
Quartus II using MegaWizard
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Black-boxing a Dual-Port RAM 
(Step 1)
Black-boxing a Dual-Port RAM 
(Step 1)

Finished!!

1) Create my_ram, a dual-port
RAM megafunction in
Quartus II using MegaWizard
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Verilog Wrapper FunctionVerilog Wrapper Function
module my_ram (

data,
wraddress,
rdaddress,
wren,
wrclock,
rdclock,
q);

input [7:0]  data;
input [7:0]  wraddress;
input [7:0]  rdaddress;
input wren;
input wrclock;
input rdclock;
output [7:0]  q;

wire [7:0] sub_wire0;
wire [7:0] q = sub_wire0[7:0];

lpm_ram_dp lpm_ram_dp_component (
.rdclock (rdclock),
.wren (wren),
.wrclock (wrclock),
.data (data),
.rdaddress (rdaddress),
.wraddress (wraddress),
.q (sub_wire0));

defparam
lpm_ram_dp_component.lpm_width = 8,
lpm_ram_dp_component.lpm_widthad = 8,
lpm_ram_dp_component.lpm_indata = "REGISTERED",
lpm_ram_dp_component.lpm_wraddress_control = "REGISTERED",
lpm_ram_dp_component.lpm_rdaddress_control = "REGISTERED",
lpm_ram_dp_component.lpm_outdata = "UNREGISTERED",
lpm_ram_dp_component.lpm_hint = "USE_EAB=ON";

endmodule

Verilog Dual-Port 
RAM function A “wrapper” function 

instantiates the LPM 
and sets its ports and 
parameters
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// Verilog code which will call dual-port RAM

module top_ram (top_data, top_wradd, top_rdadd, top_we, top_wrclk, top_rdclk,
top_q);

input [7:0]      top_data, top_wradd, top_rdadd;
input top_we, top_wrclk, top_rdclk;
output [7:0]    top_q;

my_ram U1 (.data (top_data), .wraddress (top_wradd), .rdaddress (top_rdadd),
.wren (top_we), .wrclock (top_wrclk), .rdclock (top_rdclk), 
.q (top_q));

endmodule

module my_ram ( data, wraddress, rdaddress, wren, wrclock, rdclock, q)
/* synthesis syn_black_box */;

input [7:0]  data;
input [7:0]  wraddress;
input [7:0]  rdaddress;
input wren;
input wrclock;
input rdclock;
output [7:0]  q;

endmodule

2) “Black-box” my_ram in 
Synplify Pro and 
synthesize the top_ram

Note: DO NOT include my_ram.v in the
Synplify Pro input file list

Black-boxing a Dual-Port RAM 
(Step 2)

Include empty 
module for my_ram 

The Megawizard
automatically 

generates a black 
box file named 
my_ram_bb.v 

Use Synthesis Directive
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VHDL Wrapper FunctionVHDL Wrapper Function

BEGIN
q    <= sub_wire0(7 DOWNTO 0);

lpm_ram_dp_component : lpm_ram_dp
GENERIC MAP (

lpm_width => 8,
lpm_widthad => 8,
lpm_indata => "REGISTERED",
lpm_wraddress_control => "REGISTERED",
lpm_rdaddress_control => "REGISTERED",
lpm_outdata => "UNREGISTERED",
lpm_hint => "USE_EAB=ON"

)
PORT MAP (

rdclock => rdclock,
wren => wren,
wrclock => wrclock,
data => data,
rdaddress => rdaddress,
wraddress => wraddress,
q => sub_wire0

);

END SYN;

VHDL Dual-Port 
RAM function

LIBRARY ieee;
USE ieee.std_logic_1164.all;
LIBRARY lpm;
USE lpm.lpm_components.all;

ENTITY my_ram IS
PORT
(
data : IN STD_LOGIC_VECTOR (7 DOWNTO 0);
wraddress : IN STD_LOGIC_VECTOR (7 DOWNTO 0);
rdaddress : IN STD_LOGIC_VECTOR (7 DOWNTO 0);
wren : IN STD_LOGIC  := '1';
wrclock : IN STD_LOGIC ;
rdclock : IN STD_LOGIC ;
q : OUT STD_LOGIC_VECTOR (7 DOWNTO 0)
);

END my_ram;

ARCHITECTURE SYN OF my_ram IS

SIGNAL sub_wire0 : STD_LOGIC_VECTOR (7 DOWNTO 0);

COMPONENT lpm_ram_dp
GENERIC (
lpm_width : NATURAL;
lpm_widthad : NATURAL;
lpm_indata : STRING;
lpm_wraddress_control : STRING;
lpm_rdaddress_control : STRING;
lpm_outdata : STRING;
lpm_hint : STRING
);
PORT (
rdclock : IN STD_LOGIC ;
wren : IN STD_LOGIC ;
wrclock : IN STD_LOGIC ;
q : OUT STD_LOGIC_VECTOR (7 DOWNTO 0);
data : IN STD_LOGIC_VECTOR (7 DOWNTO 0);
rdaddress : IN STD_LOGIC_VECTOR (7 DOWNTO 0);
wraddress : IN STD_LOGIC_VECTOR (7 DOWNTO 0)
);
END COMPONENT;

END SYN;
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-- VHDL code which will call dual-port RAM
ENTITY top_ram  IS

(top_data, top_wradd, top_rdadd : IN STD_LOGIC_VECTOR 
(7 DOWNTO 0);

top_we, top_wrclk, top_rdclk : IN STD_LOGIC;
top_q : OUT STD_LOGIC );

END top_ram;

ARCHITECTURE inst OF top_ram IS

COMPONENT my_ram PORT (
data : IN STD_LOGIC_VECTOR (7 DOWNTO 0);
wraddress : IN STD_LOGIC_VECTOR (7 DOWNTO 0);
rdaddress : IN STD_LOGIC_VECTOR (7 DOWNTO 0);
wren : IN STD_LOGIC  := '1';
wrclock : IN STD_LOGIC ;
rdclock : IN STD_LOGIC ;
q : OUT STD_LOGIC_VECTOR (7 DOWNTO 0));

END COMPONENT;
ATTRIBUTE syn_black_box : BOOLEAN;
ATTRIBUTE syn_black_box OF my_ram:  COMPONENT IS TRUE;

BEGIN
U1 : my_ram PORT MAP ( data => top_data, wraddress => top_wradd,

rdaddress => top_rdadd, wren => top_we,
wrclock => top_wrclk, rdclock => top_rdclk, 
q => top_q);

END inst;

2) “Black-box” my_ram in         
Synplify Pro and 
synthesize the top_ram

Note: DO NOT include my_ram.vhd in
the Synplify Pro input file list

Black-boxing a Dual-Port RAM 
(Step 2)
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Black-boxing a Dual-Port RAM 
(Step 3)
Black-boxing a Dual-Port RAM 
(Step 3)

3) Compile the Output File in 
Quartus II with my_ram.v (or 
.vhd) in the project directory 
or library directory.
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Exercise 5
Please go to Exercise 5
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Laboratory Exercise 5 ReviewLaboratory Exercise 5 Review
5Creating a MegaWizard function
5“Black-boxing” the MegaWizard function
5Synthesizing the design with “black-box”
5Compiling the design in Quartus II
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Attributes & DirectivesAttributes & Directives
5 Information Attached to Design Objects to Control Design 

Analysis, Optimization & Mapping
5 Use after Initial Synthesis (& Simple Settings) to Guide 

Synplify Pro to Better Results

5 Directives
− Source Code Only

5 Attributes
− SCOPE
− Source Code
− HDL Analyst Window

Note: Please See Synplify Pro Reference Manual for a More 
Detailed Explanation on All Directives & Attributes
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DirectivesDirectives
5translate_on/off
5syn_keep
5syn_black_box
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Directives in Verilog CodeDirectives in Verilog Code
5 Verilog

− Add after the Design Object & before the Possible 
Semicolon

− Use Verilog Block or Line Comment

module module_name (port list)  /* synthesis <directive_name> = <value> */ ;

case (select)  // synthesis <directive_name> = <value>
LINE COMMENT

BLOCK COMMENT
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Directives in VHDL CodeDirectives in VHDL Code
5 VHDL

− Add after the Design Object Declaration
− Redefine Directive Every Time It Is Used

<design unit declaration> ;
ATTRIBUTE <directive_name> : <data_type> ;
ATTRIBUTE <directive_name> OF <object_name> : <object_kind> IS <value> ;

Define Attribute

Set Attritue & Value 
to Design Object
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Directive - syn_encodingDirective - syn_encoding
5 Controls the Encoding of Each Individual State Register
5 Overrides FSM Compiler
5 Apply to State Register Declaration 
5 Settings

− sequential , onehot , gray
− safe (Forces Reset State If Invalid State is Reached)

Verilog

VHDL

reg [7:0] current_state  /*  synthesis syn_encoding = “sequential” */  ;

SIGNAL current_state  :  std_logic_vector (7 DOWNTO 0);
ATTRIBUTE syn_encoding :  BOOLEAN;
ATTRIBUTE syn_encoding OF current_state : SIGNAL IS TRUE; 



280
Copyright © 2004 Altera Corporation

Directive – translate_on/offDirective – translate_on/off
5 Tells Synplify Pro to Ignore HDL Code Found between translate_off

& translate_on
5 Is Used to Ignore Simulation-Specific Code or Code Written for 

Another Tool
5 Should Always Be Used as a Pair
5 Nesting Translate Commands Is Illegal

Verilog

VHDL

assign s1 = a & b ;
// synthesis translate_off
assign s2 = a| b ;
// synthesis translate_on

s1 <= a AND b ;
-- synthesis translate_off
s2 <= a OR b ;
-- synthesis translate_on
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Directive – syn_keepDirective – syn_keep
5 Tells Synplify Pro to Maintain a Net throughout Synthesis & 

Optimization
5 Preserve Nets for 

− Probing During Simulation
− Maintain Certain Control Signals (Ex.  Clock Enable)

5 Causes a keepbuf Primitive to be Generated which Acts like a 
Placeholder
− Does Not Go into Final Output Netlist

5 Is Applied to Verilog Wires & VHDL Signals
Verilog

VHDL

wire clock_enable /*  synthesis syn_keep */ ;

SIGNAL clock_enable : STD_LOGIC;
ATTRIBUTE syn_keep : BOOLEAN;
ATTRIBUTE syn_keep OF clock_enable : SIGNAL IS TRUE;
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Directive – syn_black_boxDirective – syn_black_box
5 Tells Synplify Pro to Ignore the Internal Logic of the Module/Entity
5 Preserves Module/Entity Interface
5 Can Be Used for 

− Altera-Specific IP, Primitives & Megafunctions
− Functions Designed in Schematic or AHDL

Verilog

VHDL

module global (in, out) /*  synthesis syn_black_box */  ;
input in;
output out;
endmodule

COMPONENT global PORT (
a_in : IN STD_LOGIC;
a_out : OUT STD_LOGIC);

ATTRIBUTE syn_black_box :  BOOLEAN;
ATTRIBUTE syn_black_box OF global : COMPONENT IS TRUE; 
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Other Black Box DirectivesOther Black Box Directives
5 Directives

− black_box_tri_pins
− black_box_pad_pin
− syn_tpd
− syn_tsu
− syn_tco

5 Use When Instantiating IP Cores as Black-Boxes
− Black-Box Connectivity
− Black-Box Timing
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AttributesAttributes
5syn_maxfan
5syn_hier
5syn_useioff
5altera_io_powerup
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Attributes in HDL CodeAttributes in HDL Code
5Verlilog/VHDL

− Same Syntax as Directives

module module_name (port list)  /* synthesis <attribute_name> = <value> */ ;

case (select)  // synthesis <attribute_name> = <value>
Verilog LINE COMMENT

Verilog BLOCK COMMENT

<design unit declaration> ;
ATTRIBUTE <attribute_name> : <data_type> ;
ATTRIBUTE <attribute_name> OF <object_name> : <object_kind> IS <value> ;

VHDL
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Attributes in SCOPE EditorAttributes in SCOPE Editor
5 Recommended Way to Set Attributes

− All Constraints (except Directives) in One Location
5 Selecting the Object Type Limits the Object Drop-Down Menu to Only Those 

of That Type
5 Selecting the Object Limits the Attributes Drop-Down Menu to Only Those 

Applicable to That Object
5 Description Column Defines the Attributes Functionality



287
Copyright © 2004 Altera Corporation

Attributes in HDL AnalystAttributes in HDL Analyst

Right-Click on Object & Select 
SCOPE  ⇒Edit Attributes

Select Attribute 
from Drop-Down 
Menu & Set Value
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Attribute – syn_maxfanAttribute – syn_maxfan
5 Controls the maximum fanout
5 Results in duplication of the Driver of the Net
5 Specify Integer Value
5 Is Applied to Input, Registered Output, or Net 

Verilog

VHDL

reg en /*  synthesis syn_maxfan = 10  */ ;

SIGNAL en : STD_LOGIC;
ATTRIBUTE syn_maxfan : INTEGER;
ATTRIBUTE syn_maxfan OF en : SIGNAL IS 10;
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λ
λ
λ

3
3
3

Example:  syn_maxfanExample:  syn_maxfan
One 
Register 
Driving 32 
Registers

syn_maxfan default syn_maxfan = 10

Register 
Replicated 
into Four
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Attribute – syn_hierAttribute – syn_hier
5 Controls the Amount of Flattening Across Instance Boundaries
5 Is Applied to Modules/Architectures
5 Settings

− Soft (Default) – Flattens Current Level if Needed for Optimization
− Flatten : Flattens All Hierarchy Levels below but Not Current Level
− Firm – Preserves Current Level’s I/O Interface but Allows Cell Packing
− Hard – Preserves Current Level I/O Interface
− Remove – Removes Current Level; Lower Levels Unaffected

5 Can Use Multiple Settings Together

Verilog

VHDL

module reg4 (clk, rst, d, q) /*  synthesis syn_hier = “hard” */ ;

ARCHITECTURE rtl OF reg4 IS
ATTRIBUTE syn_hier : STRING;
ATTRIBUTE syn_hier OF rtl : STRING IS “hard”;
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Example:  syn_hierExample:  syn_hier
syn_hier = “hard”

syn_hier = soft

Sub-Modules/Entities 
inc (Incrementor) & 
reg4 (Registers) 
Maintained 

Cross-Boundary 
Optimization Occurs & 
a Counter is Inferred
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Attribute – syn_useioffAttribute – syn_useioff
5 Enables/Disables I/O Register Packing

− Device Must Support
5 Is Applied to 

− Modules/Architectures For Global Setting
− Individual I/O Ports as They Are Declared

5 Settings
− 1 (TRUE) : Enables Register Packing
− 0 (FALSE) : Default

Verilog (Global Setting)

VHDL (Global Setting)

module reg4 (clk, rst, d, q) /*  synthesis syn_useioff = 1  */ ;

ARCHITECTURE rtl OF reg4 IS
ATTRIBUTE syn_useioff : BOOLEAN;
ATTRIBUTE syn_useioff OF reg4 : ARCHITECTURE IS TRUE;
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Attribute – syn_useioff (cont.)Attribute – syn_useioff (cont.)
Verilog (Individual I/Os)
module reg4 (clk, d, q);
input clk ;
input [3:0] d    /*  synthesis syn_useioff = 1  */ ;
output [3:0]  q     /*  synthesis syn_useioff = 1  */ ;

VHDL (Individual I/Os)
ENTITY reg4 IS PORT (

clk : IN STD_LOGIC;
d : IN STD_LOGIC_VECTOR (3 DOWNTO 0);
q : OUT STD_LOGIC_VECTOR (3 DOWNTO 0) );

ATTRIBUTE syn_useioff : BOOLEAN;
ATTRIBUTE syn_useioff OF d : SIGNAL IS TRUE;
ATTRIBUTE syn_useioff OF q : SIGNAL IS TRUE;

END ENTITY reg4;

After End of Port 
Declaration and 
before End of Entity
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Attribute – altera_io_powerupAttribute – altera_io_powerup
5 Controls the Power-Up State of Device I/O Registers
5 Register Automatically Packed (syn_useioff = 1 (TRUE))
5 Applied to I/O Port Definitions
5 Settings

− Low (Default)
− High

5 I/O Register Must Not Have a Predefined Preset or Clear 
Condition
− If Register Has Clear, Power-Up is Set to Low
− If Register Has Preset, Power-Up is Set to High

Note: Please Review Device Datasheets to See if Device I/O 
Support This Functionality
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Attribute – altera_io_powerupAttribute – altera_io_powerup

module reg4 (clk, d, q);
input clk ;
input [3:0] d;
output [3:0]  q  /*  synthesis altera_io_powerup = “high” */ ;
reg [3:0] q;

Verilog

VHDL
ENTITY reg4 IS PORT (

clk : IN STD_LOGIC;
d : IN STD_LOGIC_VECTOR (3 DOWNTO 0);
q : OUT STD_LOGIC_VECTOR (3 DOWNTO 0) );

ATTRIBUTE altera_io_powerup : STRING;
ATTRIBUTE altera_io_powerup OF q : SIGNAL IS “high”;

END ENTITY reg4;



296
Copyright © 2004 Altera Corporation

Exercise 6
Please go to Exercise 6
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Exercise 6 ReviewExercise 6 Review
5Setting HDL Attributes in HDL Code
5Verifying Results in both Synplify Pro & 

Quartus II
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Optimization SuggestionsOptimization Suggestions
5General Optimization
5Area Optimization
5Timing Optimization
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General OptimizationGeneral Optimization
5Remove Unnecessary Priority Structures 

On Speed-Critical Designs
− Use CASE Versus IF-THEN-ELSE

5Use Source Code that Allows for 
Architecture Specific Resources
− Instantiating or Inferring Memory
− Carry Chains
− Cascade Chains
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Area OptimizationArea Optimization
5Increase Fan-Out Limit
5Use Resource Sharing
5Use Sequential Encoding on Large FSMs
5Move Larger Logic Blocks to ESBs/EABs if 

Unused
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Timing OptimizationTiming Optimization
5 Synplify Pro

− Use Realistic Timing Constraints
− Balance Fan-Out Constraint
− Disable Resource Sharing
− Use One-Hot Encoding on FSMs
− Characterize the Timing on Black-Boxes

5 Use NativeLink to Pass Timing to Quartus II
5 Quartus II 

− Use Realistic Timing Constraints
− Use Timing Analyzer to Locate Design Bottlenecks in Silicon
− Use Floorplan to Evaluate if Placement Can Be Improved
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Quartus II ScriptingQuartus II Scripting



303
Copyright © 2004 Altera Corporation

Why Use Scripting?Why Use Scripting?
5For Executing Applications Interactively

− Ex. Integrate Multiple EDA Tools
5For Automating Routine Tasks
5To Use Less Memory that Graphic Interface
5To Perform Distributed Computing
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Quartus II SupportQuartus II Support
5Command-Line Scripting
5Tcl Scripting

5Can Be Used Together
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Tcl/TK Console WindowTcl/TK Console Window
5 Console can be invoked 

using 
− View ⇒Auxiliary Windows 

⇒Tcl/TK Console
− Pressing the      button

5 Use Source Command to 
Run Script
− source my_file.tcl

5Messages will appear in 
the Message Window 
under the System tab

Tcl Console
Window
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Tcl Scripts Dialog BoxTcl Scripts Dialog Box

5Used to View, Open & 
Execute Scripts
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Command-Line OverviewCommand-Line Overview
5Separate Executables with Smaller Memory 

Footprint 
− Improves Operation on Low Powered, Low Memory 

Workstations
5Provides Command-Line Scripting Capability

− Flexibility for Shell Scripts, Other Script Languages
− Makefile Capability Similar to Other Scriptable Tools 

Such as Synopsys DC, Primetime, etc.
− Create New Projects or Compile Existing Projects

5Compatible with Quartus II GUI
− Use GUI & Command-Line Script Interchangeably
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Command-Line ExecutablesCommand-Line Executables
5Each Executable Has Command-Line Arguments

− Access to Common Settings, Tasks
3Device, Optimization Style, Etc.
3quartus_fit --part=EP1S10F484C5

5Each Executable Creates Text-Based Reports
− Success or Failure
− Processing Information

5Help Available for each Executable & Arguments
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Command-Line Executables in v4.0Command-Line Executables in v4.0
5 13 Executables

− Analysis & Synthesis (quartus_map)
− Fitter (quartus_fit)
− Timing Analysis (quartus_tan)
− Simulator (quartus_sim)
− Assembler (quartus_asm)
− Programmer (quartus_pgm)
− Design Assistant (quartus_drc)
− Compiler Database Interface (quartus_cdb)
− EDA Netlist Writer (quartus_eda)
− Convert Programming file (quartus_cpf)
− Software Builder (quartus_swb)
− Quartus Shell (quartus_sh)
− SignalTap II (quartus_stp)
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Executables Integrated into GUIExecutables Integrated into GUI
5Tools ⇒Compiler Tool

Buttons Open Appropriate Settings Box or Report
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quartus_sh --flowquartus_sh --flow
5Performs Entire Compilation Flow
5Replaces quartus_cmd in Older Quartus II 

Scripts
− Uses Less Memory
− Use with Existing Projects for Complete 

Compile
− Example:  
3quartus_sh –flow compile filter
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Option & Assignment PrecedenceOption & Assignment Precedence

5 Quartus II Gets Options & Assignments 
From

1. Command-line Options
2. Project File (.QSF, .QPF)
3. Database Files (db directory)
4. Software Defaults

5 Options to Skip Project Files
− --import_settings_files=off (reading settings)
− --export_settings_files=off (writing settings)
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Sample Command-Line ScriptSample Command-Line Script
# Perform a batch compile on a new project.

# Create a new project called filtref targeting a Stratix family & optimize for
#   speed
quartus_map filtref --optimize=speed --family=stratix

#Fit the design using Fastfit and a 1S10F484C5 part
quartus_fit filtref --fast_fit=on --part=ep1s10f484c5

#Create a POF for the project
quartus_asm filtref

# Perform Timing Analysis – Must be run before Generate EDA Simulation Netlist
quartus_tan filtref

# Generate Verilog EDA Simulation Netlist for NC-Sim, maintaining the design
#   hierarchy
quartus_eda filtref --simulation --tool=ncsim --format=verilog 

--maintain_design_hierarchy=on

# Rerun Timing Analysis targeting a different speedgrade
quartus_tan filtref --speed=7
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Getting HelpGetting Help
5Help Is Integrated with each Executable

− Description, Options, Examples
5Get Help by Typing

− <executable> -h

3Command Description 
3Available Options

− <executable> --help=<option>

3Option Description
− quartus_sh –qhelp

3Command Browser
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Command-Line Help: <command> -hCommand-Line Help: <command> -h
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Command-Line Option Help: 
<command> --help=<option>
Command-Line Option Help: 
<command> --help=<option>
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Help: quartus_sh --qhelpHelp: quartus_sh --qhelp
5Command-Line & Tcl API Help Browser
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Tcl API OverviewTcl API Overview
5New Tcl API Improves Ease of Use

− Align with Major EDA Vendor Solutions
− Similar Format to Synopsys SDC Used by 

PrimeTime & Design Compiler
5Reduce Memory Requirements
5Commands Are Grouped in Tcl Packages

− Loaded on Demand
− Reduces Runtime Memory of Executable
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Tcl/Tk BasicsTcl/Tk Basics
5Tcl = Tool Command Language

− Tk Is an Extension of Tcl, Used for GUIs
5Works on PCs & Workstations
5Interpreted Programming Language

− Scripts Do Not Need to Be Compiled
5Quartus II Uses Tcl/Tk Supplied by 

Scriptics
5Quartus II Contains a Tcl Text Editor with 

Syntax Coloring
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5 Command Substitution
− puts “The variable value is [expr $var + $var]”

− Writes “The variable value is 6” to the Message Window

5 Variable Substitution
− puts “The variable value is $var”

− Writes “The variable value is 3” to the Message Window

Tcl SyntaxTcl Syntax
5 Tcl is Case Sensitive
5 Basic Syntax

− command arg1 arg2 arg3 …
− Example : set var 3

Sets variable “var” equal to 3

Name preceded by “$” is replaced 

with value of name

Command within “ [ ] ” is replaced 

with results of command
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Executable Support for Tcl APIExecutable Support for Tcl API
5Four Executables Are Also Tcl Interpreters

− quartus_sh, quartus_tan, quartus_sim, 
quartus_cdb

5Run a Specific Tcl Script
− quartus_sh -t <script file>

5Run a Particular Tcl Command
− quartus_sh --tcl_eval <Tcl command>

5Open an Interactive Tcl Shell (Similar to 
PrimeTime)
− quartus_sh -s
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Executable Support for Tcl APIExecutable Support for Tcl API
5Uses for Tcl with each Executable

− quartus_sh
3Make Project Settings, Do Basic Reporting

− quartus_tan
3Perform Basic & Advanced Timing Analysis

− quartus_cdb
3Do Back Annotation, LogicLock, Chip Editor

− quartus_sim
3Perform Simulations

5Different Packages Available in Each Shell
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Executable Support for Tcl APIExecutable Support for Tcl API
5When Do I Use Tcl Interpreter 

Functionality?
− Use -t, --tcl_eval, or -s Switches Only if 

Processing Tcl Commands or Scripts
− Running Executables with Other Command-

Line Options Is Like Running It From GUI
5Tcl Interpreter Executables Align with Tcl 

Package Functionality
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Tcl PackagesTcl Packages
5 13 Packages

− Project Creation, Assignments ::quartus::project
− Device Information ::quartus::device
− Advanced Device Information ::quartus::advanced_device
− Simple Compiler Flows ::quartus::flow
− Compute, Report Timing Paths ::quartus::timing
− Advanced Timing Netlist Info ::quartus::advanced_timing
− Perform Simulations ::quartus::simulator
− Access Report Data ::quartus::report
− List Paths Functionality ::quartus::timing_report
− Back Annotation ::quartus::backannotate
− Manipulate LogicLock Regions ::quartus::logiclock
− Access Chip Editor Functions ::quartus::chip_editor
− Miscellaneous Commands ::quartus::misc

5 Some Packages Must Be Loaded Manually Before Use
− See Appendix
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Running a Quartus II Tcl ScriptRunning a Quartus II Tcl Script
1) Tcl Console Window
2) Tcl Scripts Dialog Box
3) Command Line Arguments
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Tcl/TK Console WindowTcl/TK Console Window
5 Console can be invoked using 

− View ⇒Auxiliary Windows ⇒
Tcl/TK Console

− Pressing the      button
5 Use Source Command to Run 

Script
− source my_file.tcl

5 Messages will appear in the 
Message Window under the 
System tab

Tcl Console
Window
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Tcl Scripts Dialog BoxTcl Scripts Dialog Box

5Used to View, Open & 
Execute Scripts
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Old & New API ComparisonOld & New API Comparison
5Old Tcl API Syntax

− cmp add_assignment “” “” “” FAMILY apex20ke
5New Tcl API Syntax

− set_global_assignment -name FAMILY apex20ke
5New Tcl API

− Don’t Need Knowledge of Constraint File Type
− If User Gives Incorrect Arguments, Message 

Displayed Explaining Correct Usage & What 
Arguments are Supported
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Old & New API ComparisonOld & New API Comparison
54.0 API not Compatible with Old API
5Old API Supported by quartus_cmd
5Recommend New Scripts Target New API

− Existing Scripts Should Be Rewritten
− No Development on Old API
− No Conversion Utility
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Sample Tcl ScriptSample Tcl Script
# Set the project name to filtref
set project_name filtref

# Open the Project. If it does not already
#   exist, create it
if [catch {project_open $project_name}] 

{project_new $project_name}

# Set Family
set_global_assignment -name family Stratix

# Set Device
set_global_assignment -name device 

ep1s10f484c5

# Optimize for speed
set_global_assignment -name 

optimization_technique speed

# Turn-on Fastfit
set_global_assignment -name 

fast_fit_compilation on

# Generate a NC-Sim Verilog simulation
#   Netlist
set_global_assignment -name 

eda_simulation_tool ncsim_verilog

# Generate a NC-Sim Verilog simulation
#   Netlist
set_global_assignment -name 

eda_simulation_tool ncsim_verilog

# Create an FMAX=50MHz assignment called
#   clk1 to pin clk
create_base_clock -fmax 50MHz -target clk 

clk1

# Create a pin assignment on pin clk
set_location_assignment -to clk Pin_AA14

# One way
# Always write the assignments to the
#   constraint files before doing a system
#   call. Else, stand-alone files will not
#   pick up the assignments
export_assignments
qexec quartus_map
qexec quartus_fit

# Better way - FLOW will export_assignments
#  automatically. FLOW will also take care
#   of Smart Recompile
#   execute_flow -compile

# Close Project
project_close
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Tcl ToolbarTcl Toolbar

Enter Tcl Commands 
for each Button
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Generate TCL FileGenerate TCL File
5Generate a TCL Script File 

for a Project
− GUI
3 Project ⇒Generate TCLFile

− TCL command
generate_tcl_file <name>
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Quartus II APIQuartus II API
5 Quartus II Help Lists the Tcl Commands
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Getting HelpGetting Help
5Help Is Integrated in the Tcl Shell

− Description, Commands, Examples
5Get Help in Tcl Shell by Typing

− help -pkg <package>
− <command> -h (short help)
− <command> -long_help or help -cmd <command> 
− quartus_sh --qhelp
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Tcl API Short HelpTcl API Short Help
5Shows Usage & Brief Description About an 

Available Tcl Command
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Tcl API Long HelpTcl API Long Help
5 Shows Usage & Brief Description About an Available Tcl 

Command
5 Shows Examples & List of Possible Return Values

− <Tcl Command> -long_help or help -cmd <Tcl Command>
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Command-Line & Tcl ScriptingCommand-Line & Tcl Scripting
5Use Command-Line Scripting for

− Compiling Existing Projects
− Common Global Assignments

5Use Tcl Scripting for
− Custom Timing Analysis Reports
− Any Assignments or Settings
3Pin Assignments, for Example

− Power Users
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Command-Line & Tcl ScriptingCommand-Line & Tcl Scripting
5Mix-and-Match for Complete Solution
5Example

− Synthesize Design Files with quartus_map
− Assign Pins with a Tcl Script
− Place & Route with quartus_fit
− Analyze Timing with quartus_tan
− Create Custom Timing Report with a Tcl Script
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Running Script Files in QuartusRunning Script Files in Quartus
5Quartus  

− Tcl console source path/filename.tcl
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Scripting in Synplify ProScripting in Synplify Pro
While performing functions like 
creating a project, setting 
synthesis options, & executing 
commands in Synplify Pro, the 
TCL Script Window is Recording 
the Tcl Equivalent Commands.  
These can be copied into a Tcl 
file ( <filename.tcl> ) for future 
automation.
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Recording Tcl CommandsRecording Tcl Commands
5 Records Tcl Commands into a File as You Work in 

Synplify Pro
5 recording

− -on 0 | 1
3Turns Recording Session On or Off

− -file <logfilename>.tcl
3Returns the Name of the Target Log File (If No Log 

File is Specified)
3Sets the Name of the Target Log File

− -save <logfilename>.tcl
3Updates the Current History Log
3Save History to Log File if File Name is Specified
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Creating a New Tcl Synthesis 
Script
Creating a New Tcl Synthesis 
Script
1. Open a Text File
2. Create or Open a Project
5 project –new <directory_path\project_name>
5 project –load <directory_path\project_name>

3. Add Files
5 add_file –vhdl <filename>.vhd
5 add_file –verilog <filename.v
5 add_file –constraint <filename>.sdc
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Creating a New Tcl Synthesis 
Script
Creating a New Tcl Synthesis 
Script
4. Set Design Synthesis Options & Output
5 set_option 
5 Ex. Set option –technology Mercury

5 project –result_file <filename>
5 project –log_file <filename>

5. Set the File & Run Options
5 project –save 
5 project –run synthesis
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Sample TCL FileSample TCL File
# 2) Open New Project
project -new 

# 3) Add Files
add_file -vhdl file1.vhd
add_file -vhdl file2.vhd
add_file -vhdl top_level.vhd
add_file -constraint top_level.sdc

# 4)  Set Design Syntheis Options
#           And Output
set_option -technology APEX20KC
set_option -part EP20K100C
set_option -speed_grade -7
set_option -frequency 50.0

# 4) [cont.]
set_option -result_file 
top_level_imp1.vqm
set_option -log_file top_level_imp1.srr

# 5) Set File & Run Options
project -save top_level.prj
project -run synthesis
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Sample SDC FileSample SDC File
# Add Timing Constraints
define_input_delay -default 100
define_output_delay -default 100
define_input_delay {DATA0 [7:0]} 10

# Put a scalar signal on a pin location 159
define_attribute SEL altera_chip_pin_lc "163"

# Assign pin locations to all bits of a bus
define_attribute {DATA0[7:0]} altera_chip_pin_lc “40, 41, 42, 43, 46, 47, 48, 49"

# Assign pin locations to 2 bits of an 8 bit bus
define_attribute {DATA1[3]} altera_chip_pin_lc "113"
define_attribute {DATA1[7]} altera_chip_pin_lc "119"
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Running Script FilesRunning Script Files
5Synplify Pro

− Run -> Run TCL Script
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Summary
5Introduction to Altera & Altera Devices
5PLD Design Flow
5Quartus II / Synplify Pro Overview
5Design & Synthesis with Synplify Pro
5Quartus II Project Management
5Quartus II Compilation
5NativeLink
5Optimizing Designs with Synplify Pro & Quartus II
5TCL Scripting
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Altera Technical Support
5 Reference Quartus II On-Line Help 
5 Consult Altera Applications (Factory Applications Engineers)

− Hotline:  (800) 800-EPLD (7:00 a.m. - 5:00 p.m. PST)
− MySupport:  http://www.altera.com/mysupport

5 Field Applications Engineers: Contact Your Local Altera Sales Office
5 Receive Literature by Mail: (888) 3-ALTERA
5 FTP: ftp.altera.com
5 World-Wide Web: http://www.altera.com

− Use Solutions to Search for Answers to Technical Problems  
− View Design Examples
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Instructor-Led Training

With Altera's instructor-led training courses, you can:

ºListen to a lecture from an Altera technical training 
engineer (instructor) 

ºComplete hands-on exercises with guidance from 
an Altera instructor 

ºAsk questions and receive real-time answers from 
an Altera instructor 

ºEach instructor-led class is one day in length (8 
working hours).

Learn More Through Technical Training 

On-Line Training

With Altera's on-line training courses, you can: 

ºTake a course at any time that is convenient for you

ºTake a course from the comfort of your home or 
office (no need to travel as with instructor-led courses) 

ºEach on-line course will take approximately 2-3 
hours to complete. 

www.altera.com/training
View Training Class Schedule & Register for a Class

http://www.altera.com/training
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Synplicity Technical Support
5 Synplify Online Support[SOS] and Synplify Newsgroup

3http://www.synplicity.com/support/logon_news/log_
news.html
3news://news.synplicity.com/Synplicity.Synplify

5 Synplify First Level Support
3Solutions to Common Designer Issues & Questions
3Can be accessed from S.O.S

5 Send email to support@synplicity.com
5 Call the Technical Support Hotline at (408) 215-6000
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AppendixAppendix
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Appendix
5Quartus Memory Editor
5More Attributes & Directives
5DSP MAC Support for Stratix
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Memory EditorMemory Editor
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Memory EditorMemory Editor
5Create or Edit Memory Initialization Files in Intel 

Hex (.HEX) or Altera-Specific (.MIF) Format

5Design Entry 
− Use to Initialize Your Memory Block (Ex. RAM, ROM) 

during Power-Up

5Simulation
− Use to Initialize Memory Blocks before Simulation
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File ⇒New ⇒Other Files tab

HEX format or
MIF format

Create Memory Initialization FileCreate Memory Initialization File
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Change OptionsChange Options
5View Options of Memory Editor

− View ⇒Select from Available Options
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Select the Word & Type in a Value

OR

Select the Word & Right Click to 
Select an Option from the Pop-Up 
Menu

OR

Copy & Paste from a Spreadsheet 
into a Memory File

Edit ContentsEdit Contents
5Edit Contents of the Memory File
5Save the Memory File as .HEX or .MIF File
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Memory Size WizardMemory Size Wizard
Need to Edit Size of Memory File?

5Use the Memory Size Wizard (Edit Menu)
− Edit Word Size
− Edit Number of Words
− Specify How to Handle Word Size Change
3Increasing Word Size 

− Pad Words
− Combine Words

3Decreasing Word Size
− Truncate Words from Left
− Truncate Words from Right
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Using Memory File in DesignUsing Memory File in Design

Specify MIF or HEX file in 
MegaWizard Interface
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Memory CompilerMemory Compiler
5Memory Functions are 

Organized by Type

5MegaWizard is Family-
Aware
− Select Memory Type & 

Parameters
− Appropriate 

Megafunction Selected 
Automatically
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FIFO PartitionerFIFO Partitioner
5Map Multiple FIFOs into a Single Physical 

Memory Block
5Partition M-RAM Blocks into Multiple FIFOs
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More Attributes & DirectivesMore Attributes & Directives
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More Directives & AttributesMore Directives & Attributes
Attributes
5syn_state_machine
5syn_sharing
5parallel_case / full_case

Directives
5altera_chip_pin_lc
5altera_implement_in_eab/esb
5altera_io_opendrain
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Directive - syn_state_machineDirective - syn_state_machine
5 Enables/Disables FSM Compiler for an Individual State 

Machine
5 Apply to State Register Declaration
5 Settings

− 1 or 0 (TRUE or FALSE )

Verilog

VHDL

reg [7:0] current_state  /*  synthesis syn_state_machine = 1  */  ;

SIGNAL current_state  :  std_logic_vector (7 DOWNTO 0);
ATTRIBUTE syn_state_machine :  BOOLEAN;
ATTRIBUTE syn_state_machine OF current_state : SIGNAL IS TRUE; 
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Directive – syn_sharingDirective – syn_sharing
5 Enables/Disables Resource Sharing on a Module/Entity
5 Apply to Modules/Entities Individually or Globally
5 Overrides Project Setting
5 Settings

− ON or OFF
Verilog

VHDL

Module alu (out, opcode, a, b)  /*  synthesis syn_sharing = “off” */  ;

ARCHITECTURE rtl OF alu IS
ATTRIBUTE syn_sharing :  STRING;
ATTRIBUTE syn_sharing OF rtl : ARCHITECTURE IS “off”; 
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Directive – parallel_case (Verilog Only)Directive – parallel_case (Verilog Only)

5 Forces Parallel Muliplexers Versus Priority Encoding
− User Knows Design Will Only Allow One Match at Any 

Time
5 Apply Directly to Case, Casex, or Casez Statements
Verilog
Casez (select)  // synthesis  parallel_case

4’b???1:   out = a;
4’b??1?:   out = b;
4’b?1??:   out = c;
4’b1???:   out = d;
default:     out = ‘bx;

endcase
Note: This Directive Is Unnecessary If the Input Logic Is 

Decoded Within the Same Module as the Case Statement 
as Synplify Pro Will Automatically Determine if the Input 
Conditions are Parallel
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Example:  parallel_caseExample:  parallel_case

Without 
parallel_case

With parallel_case

always @(select or a or b or c or d)
begin

casez (select) /* synthesis parallel_case */
4'b???1: out = a;
4'b??1?: out = b;
4'b?1??: out = c;
4'b1???: out = d;
default: out = 'bx;

endcase
end
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Directive – full_case (Verilog Only)Directive – full_case (Verilog Only)
5 Indicates All Possible Values Have Been Defined

− No Additional Hardware Needs to Be Generated by Synplify Pro 
to Protect Design (Preserve Signal Values)

5 Apply Directly to Case, Casex, or Casez Statements
5 May Lead to Simulation Mismatches Since Simulators Do Not 

Recognize Directives
− Use “default : ‘bx” in a Casez as an Alternative

Verilog
Casez (select)  // synthesis  full_case

4’b???1:   out = a;
4’b??1?:   out = b;
4’b?1??:   out = c;
4’b1???:   out = d;

endcase
Note: This Directive Is Unnecessary If the Input Logic Is 

Decoded Within the Same Module as the Case Statement 
since Synplify Pro Will Automatically Determine If All 
Cases Have Been Considered

What Happens when Select 
= “0000”?  Synplify Pro Will 
Generate a Latch to 
Preserve the Value of Out if 
Select = “0000”



369
Copyright © 2004 Altera Corporation

Example:  full_caseExample:  full_case
Latch

With full_case

Without 
full_case
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Attribute –
altera_implement_in_eab/esb
Attribute –
altera_implement_in_eab/esb
5 Enables/Disables Logic Implementation in Memory Blocks instead 

of Logic Cells
− ESBs : All APEX, Mercury, Excalibur
− EABs : All FLEX 10K

5 Improves Area Utilization
5 Is Applied to 

− Module Instantiation (Verilog)
− Component Declaration (VHDL)

5 Settings
− 1 (TRUE) : Enables ESB/EAB Usage
− 0 (FALSE)

Note: Please Review Device Datasheets for Rules as to when 
Logic Can Be Moved in This Way
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Attribute –
altera_implement_in_eab/esb
Attribute –
altera_implement_in_eab/esb
Verilog

VHDL

node_buf u1 (.d_in (d_in), .d_out (d_out)) 
/*  synthesis altera_implement_in_esb = 1 /*  ;

COMPONENT node_buf IS PORT (
d : IN STD_LOGIC_VECTOR (3 DOWNTO 0);
q : OUT STD_LOGIC_VECTOR (3 DOWNTO 0));

END COMPONENT node_buf;
ATTRIBUTE altera_implement_in_esb : BOOLEAN;
ATTRIBUTE altera_implement_in_esb u1 : LABEL IS TRUE;

Instance Name (Label)
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Attribute – altera_chip_pin_lcAttribute – altera_chip_pin_lc
5 Specifies Pin Locations

− Assignments Passed via NativeLink (TCL File)
5 Is Applied to Individual I/O Ports as They Are Declared
5 Use @ Symbol for FLEX & ACEX Devices

Verilog (APEX, Excalibur, Mercury, Stratix)
module reg4 (clk, d, q);
input clk    /*  synthesis altera_chip_pin_lc = “20” */ ;
input [3:0] d    /*  synthesis altera_chip_pin_lc = “60,62,63,64” */ ;
output [3:0]  q     /*  synthesis altera_chip_pin_lc = “65,66,67,68” */ ;

Verilog (ACEX or FLEX)
module reg4 (clk, d, q);
input clk    /*  synthesis altera_chip_pin_lc = “@20” */ ;
input [3:0] d    /*  synthesis altera_chip_pin_lc = “@60,@62,@63,@64” */ ;
output [3:0]  q     /*  synthesis altera_chip_pin_lc = “@65,@66,@67,@68” */ ;
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Attribute – altera_chip_pin_lc
(cont.)
Attribute – altera_chip_pin_lc
(cont.)
VHDL (APEX, Excalibur, Mercury, Stratix)

VHDL (ACEX or FLEX) – Same as above but Add @

ENTITY reg4 IS PORT (
clk : IN STD_LOGIC;
d : IN STD_LOGIC_VECTOR (3 DOWNTO 0);
q : OUT STD_LOGIC_VECTOR (3 DOWNTO 0) );

ATTRIBUTE altera_chip_pin_lc : STRING;
ATTRIBUTE altera_chip_pin_lc OF clk : SIGNAL IS “20”;
ATTRIBUTE altera_chip_pin_lc OF d : SIGNAL IS “60,62,63,64”;
ATTRIBUTE altera_chip_pin_lc OF q : SIGNAL IS “65,66, 67, 68”;

END ENTITY reg4;

ATTRIBUTE altera_chip_pin_lc : STRING;
ATTRIBUTE altera_chip_pin_lc OF clk : SIGNAL IS “@20”;
ATTRIBUTE altera_chip_pin_lc OF d : SIGNAL IS “@60,@62,@63,@64”;
ATTRIBUTE altera_chip_pin_lc OF q : SIGNAL IS “@65,@66,@67,@68”;
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Attribute – altera_io_opendrainAttribute – altera_io_opendrain
5Enables Open Drain Mode on Device I/O
5Applied to Output & Bi-Directional Ports
5Settings

− 1 (TRUE) : Enables Open-Drain Mode
− 0 (FALSE) : Default

Note: Please Review Device Datasheets to See if Device I/O 
Support This Functionality

module node_buf (datain, dataout);
input [3:0] datain;
output [3:0]  dataout /*  synthesis altera_io_opendrain = 1  */ ;

Verilog

VHDL
ENTITY node_buf IS PORT (

datain : IN STD_LOGIC_VECTOR (3 DOWNTO 0);
dataout : OUT STD_LOGIC_VECTOR (3 DOWNTO 0) );

ATTRIBUTE altera_io_opendrain : BOOLEAN;
ATTRIBUTE altera_io_opendrain OF dataout : BOOLEAN IS TRUE;

END ENTITY reg4;
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DSP MAC Support for 
Stratix

DSP MAC Support for 
Stratix
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DSP MAC Block SupportDSP MAC Block Support
5 Different configurations:

− LPM_MULT: Plain Multipliers
3Unregistered
3Pipelined

− ALTMULT_ADD: Multipliers followed by adder
3Unregistered
3Registered

− ALTMULT_ACCUM: Multiplier followed by accumulator register
3Unregistered
3Registered

5 Width of Multiplier > 4 bits
5 To override inference, use syn_multstyle=“logic”
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Plain MultiplierPlain Multiplier
5Inferred to LPM_MULT
5Unregistered

− Parameter lpm_pipeline=0
5Pipelined

− Input / output regs must have same clock, aclr, & clken
3DFF, DFFR, DFFRE, DFFE

− Output register pipelined only if input registers pipelined
− Values for parameter lpm_pipeline
30: no pipeline
31: input registers pipelined
32: input and output registers pipelined
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Plain Multiplier ExamplesPlain Multiplier Examples

lpm_pipeline = 1
Registers ain and bin have the 
same control signals, but register 
q does not. 

lpm_pipeline = 0

ain and bin do not have the same 
control signals a and b are UNREGISTERED

All registers have the same 
control signals

lpm_pipeline = 2
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Multiply—Add OperationMultiply—Add Operation

5Inferred to ALTMULT_ADD
5Inferred when outputs of Multipliers added

− q = a * b + c * d
− q = (a * b + c * d) + (e * f + g * h)
− q = (a * b + c * d) – (e * f + g * h)

5Up to 4 Multipliers of width <= 18, in one DSP Block
5Adder without Multipliers not packed into DSP Block
5Configurations

− Unregistered
− Registered
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Unregistered ALTMULT_ADD 
Example
Unregistered ALTMULT_ADD 
Example

The multipliers and adder 
mapped to a single DSP 
Multiplier Block

ZNo registers on any of the inputs, multiplier outputs or output
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Registered ALTMULT_ADDRegistered ALTMULT_ADD

5Configuration
− Registers supported
3dff, dffe, dffr, dffre

− Up to 4 unique CLK / CLKEN pairs
3Ena3 corresponds to clock3; ena2 corresponds to clock2, etc…

− Up to 4 unique asynchronous resets
5Inference methodology

− Registers on the output of multipliers sucked into the MAC first
− Registers on input or output are sucked into the MAC next
− What cannot be sucked into the MAC implemented as regular 

atoms

Advanced Synthesis Topics for Altera CPLD
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Registered ALTMULT_ADD 
Example
Registered ALTMULT_ADD 
Example

Multiplier output registers 
packed into DSP Block first

Subsequently, remaining 
registers packed into DSP 
Block

Advanced Synthesis Topics for Altera CPLD
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Other MultipliersOther Multipliers

5Constant Multiplier implemented as logic 
− Better quality of results than mapping it to 

MAC
5Variable Multiplier Inputs of type (a*b+c) 

mapped to DSP MACs
− Interpreted as (a*b+c*1)

Advanced Synthesis Topics for Altera CPLD
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Multiply—Accumulate OperationMultiply—Accumulate Operation
5 Inferred to ALTMULT_ACCUM
5 Inferred when Multiplier followed by accumulator register

− q = q + a * b
− q = q  - a * b

Z Width of inputs <= 18, in one DSP Block
Z Output width <= 52 bits
Z LPM_MULT inferred if output width > 52 bits

Basic ALTMULT_ACCUM

Advanced Synthesis Topics for Altera CPLD
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Sload_mux Pin InferrenceSload_mux Pin Inferrence

5sload_mux pin of altmult_accum is inferred
5Loads value at output of multiplier without 

having to reset register

Advanced Synthesis Topics for Altera CPLD
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Registered ALTMULT_ACCUMRegistered ALTMULT_ACCUM
5 Inputs & output of multiplier can be registered

− dff, dffe, dffr, dffre
5 Up to 4 unique CLK / CLKEN pairs

− Ena3 corresponds to clock3; ena2 corresponds to clock2, etc…
5 Up to 4 unique asynchronous resets

Advanced Synthesis Topics for Altera CPLD
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Stratix Scan Chains In DSP MACsStratix Scan Chains In DSP MACs
5Multiplier inputs of multadd either registered or unregistered
5Full and partial scan chains inferred 

− When registered input Ai+1 driven by the registered input Ai of the 
previous multiplier, register Ai+1 said to be scan-chained

− When one input of multiplier scan-chained, other external, said to 
be a partial scan chain

Advanced Synthesis Topics for Altera CPLD
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